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INTRODUCTION 
 
Syscon 6.5 is the software tool that configures, maintains, and operates the newest SMAR products 
line and communicates with the comprehensive new series of controllers. These controllers are all 
connected to the High-Speed Ethernet providing field network connections to well-known protocols 
such as FOUNDATION Fieldbus, Profibus, DeviceNet, AS-i and Modbus. 
 
The friendly Man-Machine Interface (MMI) provides an efficient and productive interaction with the 
user, without previous knowledge of the software. A large library of preconfigured and tested 
templates for devices, control strategies and graphic symbols makes system engineering as efficient 
and as fast as it can be. Only a minimum of data needs to be entered when defining I/Os, 
networking, and control strategies. 
 
The plant control configuration is now managed by a unique tool, the Studio302, which integrates 
all applications included in the Smar’s SYSTEM302 Enterprise Automation System and 
incorporates Windows-based Users and Groups to provide a multi-user environment. Now the 
Syscon project files have controlled access defined for each professional operating the plant and a 
precise register of the history of modifications to guarantee the integrity of the project configuration 
data. 
 
Syscon version 6.5 also includes the new Mapping Tool, which integrates Profibus, DeviceNet, 
AS-i and Modbus configurations created using the Network Configurator to the Syscon project 
configuration. Mapping Tool shows the memory mapping from controllers and instruments on the 
network, blocks and I/O points, and non-standard I/O connections that are available for mapping. 
Refer to the Mapping Tool Tutorial on this manual for further details about the tool. 
 
Syscon 6.5 runs on Microsoft® Windows. 
 
This manual refers to the version 6.5 of Syscon available on SYSTEM302 version 8. 
 
 
 
 
This product is protected by US patent numbers 6,095,674; 5,841,654 and other U.S. Patents 
pending. 
 
 
 
 
 
 
 
 
 
 
 

NOTE 

It is recommended that you read and follow the installation procedures described on the 
SYSTEM302 Installation Guide included on the product package. 
Further information about SYSTEM302 version 8 is also available on the Studio302 User’s 
Manual, which is included on the SYSTEM302 Installation media. 
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Section 1 
 

1.1 

 

GETTING STARTED 
 
Starting on System302 version 7.0, Syscon is only executed from the Studio302 application. 
 
From the Start menu, select Programs > System302 > Studio302 and click Studio302, as 
indicated in the next figure: 
 

 
Figure 1.1. Starting Studio302 

 

Click the button on the Studio302 toolbar to run Syscon 6.5. 
 

 
Figure 1.2. Starting Syscon 

 
 

Using Syscon in Stand Alone Mode 
 
In Stand Alone mode, Syscon will save the configuration files in the local machine, and the 
Database Manager will not manage the alterations made to the configurations. 
 
 

Using Syscon in Multi-User Mode 
 
In Multi-User mode, the Database Manager manages all Syscon configuration files, which means 
that any configuration file created using Syscon will be saved in a common storage folder and the 
access of all machines connected to the communication network to the files will be controlled. 
 
To guarantee that the configuration file saved in the Database Manager reflects the most recent 
alterations, it is necessary to execute the Commit procedure. Open the configuration file using 

Syscon and click the button Commit  on the main toolbar. The Database Manager will apply 
the alterations and manage the information for the other machines. 
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IMPORTANT 

To update the configuration file at the machine in View Mode using the Commit procedure, 
Syscon communication must be in Offline Mode. 

 
 
To discard the alterations applied to a local file and restore the original configuration file from the 

Database Manager, click the button Revert  on the main toolbar. 
 
To edit a configuration file managed by the Database Manager, you must have the access rights to 
change that file. Also, the file must be available for edition, which means that there can’t be another 
user editing the same configuration. 
 

The button Edit/View Mode  will only be available on the main toolbar when the Database 
Manager is being executed and the configuration file has been already imported to the current 
Studio302 Database. 
 
When a Syscon configuration file is on View Mode, it can not be altered, because another user 
may be editing that same file or because the current user does not have access rights to that file. 
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SYSCON 6.5 USER INTERFACE 
 
 

Working with a Strategy Configuration 
 
A strategy configuration file (.ffp) brings together all the elements of a fieldbus network configuration. 
 
The configuration file contains information about the plant application and the plant Fieldbus 
Network. 
 
 
Creating an Area 
 

To create an area, click the button New  on the main toolbar and select the option Area. 
 
The Setup New Area dialog box will open. Type the name for the area and click Ok to conclude. 
The main window will open: 
 

 
Figure 2.1. Strategy Configuration Main Window 

 
Syscon will automatically create a folder with the selected configuration name inside the selected 
folder. If you are using Syscon in Multi-User mode, the default path for the configuration files is 
C:\Program Files\Smar\ConfigurationWorkspace\Client\CWFiles\System302. 
 
 
Creating a HSE Area 
 

On the main toolbar, click New  and select the option HSE Area. 
 
In the Setup New Area dialog box, type the name for the area and click Ok to conclude. Syscon 
will automatically create a HSE area adding the fieldbus channel and the Foundation Fieldbus HSE 
Host. 
 
In Multi-User mode, the default path for the configuration files is C:\Program 
Files\Smar\ConfigurationWorkspace\Client\CWFiles\System302. 
 
The main window will open as indicated in the figure below: 
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Figure 2.2. HSE Area 

 
 
Converting a SE Area to a HSE Area 
 
From Syscon version 6.2 on, the SE configuration can be converted to a HSE configuration, which 
means that a DF51 bridge with H1 Fieldbus channels can be replaced with a DF63, and the field 
devices created in the H1 channels will be connected to the channels from the new bridge. On the 
other hand, blocks and parameters that are not compatible with the new bridge should be replaced 
causing the least possible impact to the plant control strategy. 
 

ATTENTION 

It is not possible to directly convert the SE area using a DF51 bridge to a HSE area with DF62. 
First, it is necessary to execute the steps described in this subsection to convert the SE area to a 
DF63 strategy configuration. 
Then, the DF63 should be replaced with the DF62 using the Exchange procedure described in 
details in section Exchanging Devices at Section 3 of this manual. 

 
In the File menu, select the option SE to HSE Replacement to open the dialog box: 
 

 
Figure 2.3. Converting the SE Area to a HSE Area 

 
Select the configuration file that will be converted and click Open. See the example below: 
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Figure 2.4. Selecting the SE Area 

 
NOTE 

A SE area may have two or more bridges. When converting this type of area, each bridge DF51 
is replaced with the DF63, respecting the topology of the channels and devices connected to 
each H1 channel. 

 
Wait a few seconds while the strategy configuration is converted. The new area with the DF63 is 
displayed in Syscon. 
 

 
Figure 2.5. Converting a SE Area 

 
The file Syscon.ini has a section named Default ReplacementSeToHse, which indicates the 
correspondence of old blocks in the DF51 that should be replaced by DF63 blocks. 
 
For each converted block during the bridge replacement, Syscon creates a log file in XML format 
that contains the discrepancies between blocks. These XML files are stored in the folder 
corresponding to the current configuration. 
 
To open the XML file of a block, go to the File menu and select the option Exchange XML Viewer 
to open a dialog box and select the XML file. See the example below: 
 

 
Figure 2.6. XML log files for blocks 
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Select the icon of the desired file and click Open. The XML Viewer window shows the alterations 
made to convert the strategy configuration, that is, attributes that were replaced in the new bridge 
and blocks that had to be deleted. Select the icon of a block to see the details about compatible and 
non-compatible parameters. 
 

 
Figure 2.7. XML Viewer Window 

 
Refer to subsection Using the XML Viewer Window at the end of this section for further details 
about the XML Viewer window. 
 
 
Creating an Area from a Template 
 
You can create an area from a HSE template. This file will be automatically created with the HSE 
Host, the bridges and devices, the resource and transducer blocks for each device, and the Flexible 
Function Blocks. 
 

Click New  on the main toolbar and select the option Predefined Area. The New Area dialog 
box will show the list of templates available for each linking device. Click each template icon to view 
the details and attributes: 
 

 
Figure 2.8. Predefined Areas 
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Select the icon of the area template and click Ok. The Setup New Area dialog box will open. Type 
the name for the area and click Save. 
 
The main window will open and the selected strategy configuration will be displayed. The figure 
below shows the example for the template DF62 Linking Device HSE 4xH1 FF: 
 

 
Figure 2.9. Example of an area template 

 
IMPORTANT 

Syscon users can not create predefined area templates. Templates are defined by the devices’ 
manufacturers. 

 
 
Opening an Area 
 

To open an existing area, click Open  on the main toolbar. The Open dialog box will appear. 
Click the area icon and click Open. 
 

NOTE 

Depending on the number of blocks and devices included in an area, Syscon may take a few 
minutes to open the strategy configuration. 

 

Checking the version 
Starting from version 5.10, Syscon verifies if the strategy configuration was generated by previous 
or later versions. If you are trying to open a strategy configuration generated in an older Syscon 
version, the following message will open: 
 

 
Figure 2.10. Version Mismatch Message Box 
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To upgrade the configuration, go to the File menu and click Save as, typing a new name for the 
area or using the same name to override the old area. 
 
If you upgrade the configuration converting it to the new file format, it won't be possible to open the 
configuration in an older Syscon version again. 
 
If Syscon detects that you are trying to open a strategy configuration that was generated in a newer 
version, the following message will open: 
 

 
Figure 2.11. Version Mismatch Message Box 

 
IMPORTANT 

Versions prior to 5.10 do not verify the strategy configuration. Those versions will open the area 
generated in a newer version causing no error warnings, but the consistency of the configuration 
will not be assured. 

 
 
Saving an Area 
 
To save the changes made to the strategy configuration or any of its parts, such as the Process Cell 

window or the Strategy window, click Save  on the main toolbar. 
 

NOTE 

The template is not part of the plant configuration. It is necessary to set the focus on the 
Template window and click Save to save the changes made to the template configuration. 

 
 
Creating a Copy of the Area 
 
To create a backup copy or rename the area, go to the File menu and click Save as. Type a new 
name for the area and click Save. A new folder will be created with the name of the area and the 
related files will be stored in this folder. 
 

IMPORTANT 

This option will only be available in Advanced Mode. The copy of the configuration file will be 
saved in the local machine, when Syscon is operating in Multi-User mode. 
This copy of the configuration file will no longer be managed by the Database Manager. A 
message box will indicate that the user will be working in the Stand Alone mode. Mapping Tool 
and FFB procedures will not be available in the Stand Alone mode. 

 
 
Printing the Strategy Configuration 
 
From the File menu, click the option Printer Setup to open the Page Setup dialog box to set 
personal printing preferences. These preferences include the page orientation, the tray from which 
paper is sent, and the number of copies printed. 
 

Printing the configuration file 

Select the main window and click the button Print  on the main toolbar. The Print Configuration 
dialog box will open. Select the items from the area to be printed: 
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Figure 2.12. Print Configuration Dialog Box 

 
Process Control Configuration: Select this item to print the information about the Process Control 
Configuration. 
 

General Information: prints the general information about the configuration. 
 
Blocks: prints the information about the blocks, listed by control modules. 
 
FB Links: prints the information about the links between those blocks. 
 
Other Components: prints further information about the Process Control Configuration. 

 
Multi Link Topology: Select this item to print the information about the topology, with the bridges 
and fieldbuses. 
 
Fieldbus Configuration: Select this item to print the information about the Fieldbus Configuration. 
 

General Information: prints the information about the configuration. 
 
Blocks: prints the information about the blocks, listed by devices. 
 
FB Links: prints the information about the links between those blocks. 
 
Other Components: prints further information about the Fieldbus Configuration. 

 
Device List: Select this item to print the information about the devices and their attributes. 
 
Block List: Select this item to print the information about the blocks. 
 

General Information: prints the information about blocks, their attributes and location. 
 
Parameter Values: prints the information about the parameters configured for the blocks. 
 
FB Links: prints the information about the connected parameters. 

 
FB Link List: Select this item to print the list with all of the links in the configuration. 
 

General Information: prints the general information about the links. 
 
Connected Parameter: prints the information about the parameters. 

 
Schedule: Select this item to print the information about the Schedule, including both Function 
Block Execution Schedule and Traffic Schedule. 
 
Click Ok to close this dialog box and print the strategy configuration. 
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Printing the control strategy drawing 

Select the Strategy window and click the button Print  on the main toolbar. Configure the printer 
options and click Ok to print the control strategy. 
 

Print the configuration to a file 
This option is only available when you select the main window. Go to the File menu and click Print 
to File. The Print Configuration dialog box will open. Select the items from the area to be printed, 
as described above, and click Ok. 
 
Then, the Save As dialog box will open. Select the folder to save the file, type the file name and 
click Save. The file will be saved as a Report File in the txt format. 
 
To print this file, open the Windows Explorer window and locate the file. Then right-click the file icon 
and click Print. The strategy configuration will be printed. 
 

Print Preview 
This option allows you to view the configuration report before printing it. Go to the File menu and 

click Print Preview, or click the Print Preview button  on the main toolbar. It will be necessary 
to select the items from the area to be printed on the Print Configuration dialog box. Click Ok and 
the Preview window will open. 
 

 
Figure 2.13. Print Preview: Strategy Configuration 

 
On the Preview window toolbar: 
 

 Shows the previous page. 

 Shows the next page. 

 Shows the entire page on the screen. 

 Shows two pages at the same time on the screen. 

 Activates the Zoom tool. Click the page to zoom in. 

 Deactivates the Zoom tool. Click the page to zoom out. 
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 Indicates the number of the page(s) being displayed at the moment. 

 Opens the Print dialog box to print the report. 

 Closes the Preview window and returns to Syscon. 

 
 

Preferences 
 
To set the strategy configuration preferences, go to the File menu and click Preferences. The 
Preferences dialog box will open. 
 
Block Tab - Tag Policy 
 
Choose one of the options for the block tag name generation: 
 

• Default: when creating a block at the Strategy or the device, the tag will have the default 
format: ["block" + id number]. 

• Device: when creating a block attached to the device, the tag will have the device tag 
concatenated with the block mnemonic and an internal sequential number: [device 
tag + separator + block mnemonic + id number]. 

• Strategy: when creating a block attached to the strategy, the tag will have the Strategy tag 
concatenated with the block mnemonic and an internal sequential number: 
[strategy tag + separator + block mnemonic + id number]. 

 

 
Figure 2.14. Block Tag Policy Options 

 
Update Block Tag: if this option is selected, the block tag will be updated when the block is moved 
to another device or control module, or when the device tag or the control module tag is changed, 
according to the options selected by the user to automatically generate block tags. 
 

HINT 

Do not select this option to prevent the block tag to be accidentally changed when the block is 
moved or the device is renamed, for example. 

 
 
Apply Template Tag Instead of Block Type Mnemonic: if this option is selected, the block tag 
from the template file will be used instead of the block mnemonic, when importing a Device, Bridge 
or Strategy template. 
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NOTE 

If the tag based on the device or the strategy exceeds 32 characters, which means that [device 
or strategy tag + separator + block mnemonic + id number] has more than 32 characters, 
the block tag will be generated according to the Default option: ["block" + id number]. 

 
 
See section Automatic Block Tag Generation for further details. 
 
 
Block Tab - Tag Composition 
 
This tab will be available if the block tag name generation is based on the device or the strategy tag. 
 
The Mnemonic Separator is a set of alphanumeric characters that separates the name of the 
device or strategy from the name of the block. 
 
Select the option to apply the device or strategy tag as a prefix or suffix to the block tag. 
 

 
Figure 2.15. Block Tag Composition Options 

 
Block Tab - Communication 
 
Select the option Block List Events to enable the Automatic Checking for the block events. The 
Automatic Checking verifies if the list of block attached to the device match the list of block attached 
to the corresponding device in the field, for all devices on the Fieldbus windows opened. If this 
option is not selected, the checking will be executed when the user opens the Block List. 
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Figure 2.16. Block Communication Options 

 
NOTE 

It is necessary to re-initialize the communication every time the Preferences for the Block List 
Events option change, so the changes will take effect. 

 
 
Block Tab - Export Tag 
 
Select the mode for the Export Tags operation and the path for the taginfo.ini file, where the tags 
will be saved. 
 

• Manual: you must execute the Export Tags command to update the information in the 
taginfo.ini file. 

• Automatic: the Export Tags operation will be executed every time a relevant online 
procedure requires the tag to be exported. In this mode, a message box will 
open for the user to confirm the Export Tags operation. 

 
Select the option Generate Alarm Information Data to generate the AlarmInfo.ini file that provides 
the information related to alarm and events configured in Syscon to the A&E Server. The file is 
automatically created when executing the Export Tags operation. 
 

 
Figure 2.17. Export Tag Options 
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Device and Bridge Tab 
 
Set the options to automatically create and configure blocks, parameters and internal links when a 
device or bridge is added to the configuration, according to the Capabilities File. 
 

 
Figure 2.18. Device & Bridge Options 

 
Creation Based on Default Template: Select this option to create the blocks, parameters and 
internal links based on the Default Template file of the device being created, located in the 
corresponding Device Support folder. If the Default Template is not found, Syscon will automatically 
create the Resource Block and the Transducer Blocks of the selected device. 
 
Create Resource Block: Select this option to automatically create the Resource Block of the 
selected device, according to the Capabilities File. 
 

MODE_BLK.TARGET Parameter: Select the default initial value for the Mode Block parameter: 
AUTO or OOS. 

 
Create Transducer Blocks: Select this option to automatically create the Transducer Blocks of the 
selected device, according to the Capabilities File. 
 

MODE_BLK.TARGET Parameter: Select the default initial value for the Mode Block parameter: 
AUTO or OOS. 

 
 
Strategy Tab 
 
Select the default block format to be used when a block is added to the Strategy window. The ellipse 
is the default graphical representation for a block in Syscon. 
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Figure 2.19. Strategy Options 

 
The following figure shows the different block formats: 
 

 
Figure 2.20. Block Formats 

 
 
Pack and Go Tab 
 
All of the Device Support files related to the strategy configuration, including the DD and CF files, 
can be packed and sent to another machine, where Syscon will unpack the files and import these 
files. For example, when there are old revisions of DD and CF files and the strategy configuration 
requires a newer revision. 
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Figure 2.21. Pack & Go Options 

 
No Compactor: the configuration package will be a folder that contains all of the necessary files. 
 
Use GZip Compactor: the configuration package will be a compacted file. The GZip Compactor is 
the application used to create the file. The GZip installation file is included in the SYSTEM302 
Installation DVD, at the Tools folder. The compacted file will have the extension *.tgz, and it is 
compatible with Winzip and other applications. 
 
 
Device Support Tab 
 
Select the default path to browse for files that are missing in the Device Support, using the option 
Import Device Support from the File menu. 
 

 
Figure 2.22. Device Support Options 

 
If the user selects another folder while importing the files, that new path will be the default one. This 
means that Syscon will always store the last path selected by the user. 
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Advanced User Tab 
 
Check the option Advanced Mode to enable the functionalities for the advanced users, such as 
editing the device address and save a local copy of the configuration file. 
 
Check the option Round the Macrocycle to round the value of the macrocycle to a value multiple of 
500, according to the number of elements on each fieldbus channel. If this option is not selected, 
Syscon executes the standard calculation that results on the smallest recommended possible value 
for the macrocycle, considering the elements on each fieldbus channel. 
 

 
Figure 2.23. Advanced User Options 

 
Logger Tab 
 
When eventual problems occur during the communication, such as communication or download 
failures that are not described in section Troubleshooting, enable the event logger to save the 
events that can be debugged and analyzed by Smar’s Tech Support Team. 
 
The communication events are saved on the file OFCLogger.txt located on the Syscon installation 
folder. 
 

 
Figure 2.24. Logger Options 
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Simulation Tab 
 
From System302 Version 7.3 on, you can simulate a strategy configuration with Foundation 
Fieldbus function blocks and IEC 61131-3 ladder logic. 
 
Mark the option Automatic Commissioning and the devices will be automatically configured by the 
system when Simulation mode is active. The Commission procedure relates the instrument from 
the control strategy to the physical instrument in the plant, and this procedure should be executed 
every time the communication is online. 
 

 
Figure 2.25. Simulation 

 
This option is always marked in the Syscon default installation, so the user does not have to 
execute the Commission procedure manually every time the strategy simulation is active. Refer to 
the SimulationView Online Help for details on how to configure and operate System302 Version 
7.3 in simulation mode. 
 
 
Parameter Tab 
 
Select the option to display the parameter tag as defined by the user or as defined by the device 
manufacturer. 
 

 
Figure 2.26. Parameter Tag Visualization 
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User Parameter Tag: shows the tags of the parameters as defined by the user in the User 
Parameter Tag dialog box. 
 
FF Parameter Name: shows the tags of the parameters as defined by the device manufacturer. 
 
Both - FF Name (User Tag): shows the tags of the parameters as defined by the device 
manufacturer followed by the tag defined by the user, in parentheses. 
 
 
Database Tab 
 
Check the option Enable Database to enable the Database Manager in the local machine. 
 

 
Figure 2.27. Database Options 

 
 

Automatic Block Tag Generation 
 
When you create a block and do not define a tag, the tag is automatically generated and assigned to 
the block based on the Preferences settings. 
 
 
Default Block Tag 
 
The default tag for a new block is described as follow: 
 

["Block" + id number] 
 
Where: 

Block: default text for a block. 
id number: sequential number that identifies the block internally in the area. 

 
 
Block Tag Based On Device Tag 
 
When the tag generation is based on the device tag, a new block is created in a device and the user 
does not define a tag, then the block tag will have the following format: 
 

• Using the Device Tag as prefix: 
[device tag + separator + block mnemonic + id number] 

 
• Using the Device Tag as suffix: 

[block mnemonic + id number + separator + device tag] 



SYSCON 6.5 - User’s Manual 
 

2.18 

 
Where: 

device tag: tag of the device where the block is attached. 
separator: set of alphanumeric characters that separates the name of the device 

from the name of the block. 
block mnemonic: set of characters related to the block type. 
id number: sequential number related to the mnemonic of the block. 

 
NOTE 

Assuming that the option Update Block Tag is selected in the Preferences dialog box: 
• If you change the device tag, the tag of all blocks attached to this device will be updated 

based on the new device tag. 
• If the block is moved from one device to another, the tag will be automatically updated 

based on the tag of the target device. 
 
If a block is created in the strategy and you do not define a tag, the block tag will be generated 
based on the strategy tag since the block is not attached to any device yet. Once the block is 
attached to a device, the block tag will be automatically updated based on this device tag. 
 
Yet, if a block is detached from a device, the block tag will be updated again based on the strategy 
tag. 
 

NOTE 

The general rule is if the block is not attached to a device but it is attached to a strategy, the 
block tag will be automatically generated based on the strategy tag, even if the tag generation 
method chosen is based on device tag. 

 
 
Block Tag Based On Strategy Tag 
 
When the tag generation is based on the strategy tag, a block is created in a strategy and the user 
does not define a tag, the block tag will have the following format: 
 

• Using the Strategy Tag as prefix: 
[strategy tag + separator + block mnemonic + id number] 
 

• Using the Strategy Tag as suffix: 
[block mnemonic + id number + separator + strategy tag] 

 
Where: 

strategy tag: tag of the strategy where the block is attached to. 
separator: set of alphanumeric characters that separates the name of the 

strategy from the name of the block. 
block mnemonic: set of characters related to the block type. 
id number: sequential number related to the mnemonic of the block. 

 
NOTE 

Assuming that the option Update Block Tag is selected in the Preferences dialog box: 
• If you change the strategy tag, the tag of all blocks attached to this strategy will be updated 

based on the new strategy tag. 
• If the block is moved from one strategy to another, the tag will be automatically updated 

based on the tag of the target strategy. 
 
If a block is created in the device and you do not define a tag, the block tag will be generated based 
on the device tag since the block is not attached to any strategy yet. Once the block is attached to a 
strategy, the block tag will be automatically updated based on this strategy tag. 
 
Yet, if a block is detached from a strategy, the block tag will be updated again based on the device 
tag. 
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NOTE 

The general rule is if the block is not attached to a strategy but is attached to a device, the block 
tag will be automatically generated based on the device tag, even if the tag generation method 
chosen is based on the strategy tag. 

 
 

Security 
 
The Security Manager prevents the configuration file to be open by unauthorized users. 
 
Only the Administrator may activate and deactivate the Security Manager, and change and 
configure the users’ database. The Administrator is the default user of the Security Manager. 
 
 

IMPORTANT 

When using the Security Manager for the first time, the default user will be Administrator and 
the default password will be UnitXVI. 

 
 
Enabling the Security 
 
Go to the File menu and click Security. The Security dialog box will open: 
 

1. Type Administrator as the user name. 

2. Type the password and click Login. 

 

 
Figure 2.28. Administrator Login 

 
The Active box will be enabled. 
 

 
Figure 2.29. Security Manager Enabled 

 
To activate the Security Manager, mark the option Active. When this option is selected, it is 
necessary to log to the application every time Syscon is executed. 
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To deactivate the Security Manager, unmark the option Active. The Security Manager will not 
verify users’ accesses and any user can run Syscon and open a configuration file. 
 

NOTE 

The Security Manager is deactivated by default. It is necessary to follow this procedure and 
activate the Security when using Syscon for the first time. 

 
 
User Login 
 
On the File menu, click Security to open the Security dialog box: 
 

 
Figure 2.30. Security dialog box 

 
Type the User Name, the Password and click Login. If the information is correct, the user will be 
logged in the application. 
 
Click Ok to close the Security dialog box and start using Syscon. 
 

REMEMBER 

The User Name and the Password are case-sensitive. 
 
 
User Logout 
 
To logout from the Security Manager, go to the File menu and click Security. On the Security 
dialog box, click Logout. A message box will open to confirm the operation. 
 
 
Users Management 
 
The user with the Administrator profile can change any attribute from any user. A user with the 
User profile can only change the password. 
 
On the Security dialog box, click Change to expand the dialog box. 
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Figure 2.31. Security dialog box: User Attributes 

 
The Change Password area is used to change the user’s password. The password must have at 
least four alphanumeric characters. 
 
The User List displays the users who may log to the application. 
 
The option Enabled is used to enable or disable a user account. When a user account is disabled, 
the account still exists in the database but the user will not be able to logon or run the application. 
 

Creating a User 
Only the user with the Administrator profile can add other users to the Security Manager. 
 
To add a new user to the User List: 
 

1. Type the login name for the user in the User Name text box. 

2. Type the password in the New text box and re-type the password in the Repeat text box. 

3. Type the full name of the user in the Name text box. 

4. Type a description of the user in the Descr text box. 

5. Click Add to conclude. 
 

User Profile 
The Profile option determines the type of access for the user. 
 
The Administrator (Adm) profile allows the user to create, update or remove users from the 
database. It is not possible to change the information about the Administrator. 
 
The Manager (Mng) profile allows the user to modify the password and verify the information about 
the other users. Creating, updating or removing users from the database is not enabled for the 
Manager. 
 
The User (Usr) profile allows the user to log and execute Syscon. This user does not access the 
information about other users. The Change button is disabled. 
 

Updating the Attributes for the User 
The user with the Administrator profile can change any attribute of a user. The user with the User 
profile can only change the password. 
 
To update the attributes for a user, select the name from the User List. The information about the 
user will be displayed in the Security dialog box. 
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The password, the profile, the name, the description and also the user name can be changed. 
 
Enter the new information about the user and click the button Update to save the values. 
 

Changing the Password 
To change the password: 
 

1. Select the name of the user in the User List. 

2. Type the new password in the New text box. 

3. Re-type the password in the Repeat text box. 

4. Click Confirm. 

5. Click Yes to conclude this procedure. 
 

Removing a User 
Only the user with the Administrator profile can remove users from the Security Manager. To 
remove a user from the database, select the user name in the User List and click the button 
Remove. 
 
A message box will be displayed to confirm this operation. Click Yes to remove the user or click No 
to cancel. 
 

IMPORTANT 

It is not possible to remove a user that is logged to the system. 
 
 

Using the XML Viewer Window 
 
When a defective device is replaced by a new device that has a newer or different Device Revision, 
or when you change the revision number of the device, the Exchange procedure is executed to 
verify the inconsistencies or incompatibilities between devices and make the necessary alterations 
in the strategy configuration. 
 
Blocks, parameters, and other functionalities may be lost when exchanging devices. For example, a 
block that does not exist in the new device may be replaced by a compliant block. 
 
When the Exchange procedure is executed for a bridge or device, Syscon creates a log file in XML 
format that contains the discrepancies between the instruments. This XML file is stored in the folder 
corresponding to the current configuration, in a subdirectory specific for XML log files named 
XmlExchangeLog. 
 
For example, if a device is exchanged in the configuration where the file is named 
Smar_Demo_Plant.ffp, the XML file corresponding to this substitution will be located in the Smar 
folder, and the default path is: “C:\Program Files\Smar\Conf igurat ionWorkspace\Cl ient \  
CWFi les \System302\Smar_Demo_Plan t \XmlExchangeLog”. 
 
The name of the XML file is composed by the name of the device followed by the string 
“_XmlExchangeLog” and the file extension “.xml”. For example, the device LD302 with the tag 
LD302_01 is exchanged in the strategy configuration. The name of the log file corresponding to this 
device will be LD302_01_XmlExchangeLog.xml. 
 
Blocks are also converted or replaced when a SE configuration is replaced by a HSE configuration, 
using the SE to HSE Replacement procedure (described in subsection Converting a SE Area to a 
HSE Area). This procedure exchanges the bridge DF51 with the DF63 transparently to the user. 
 
For each block converted during the SE to HSE Replacement procedure, Syscon creates a log file 
in XML format with the information related to block compatibility. The XML files are also stored in the 
folder corresponding to the current configuration, indicated above. 
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The name of the XML file for a block is composed by the name of the block followed by the string 
“_XmlExchangeLog” and the file extension “.xml”. For example, the bridge with the tag DF51 has an 
arithmetic block with the tag DF51-ARTH. The name of the log file corresponding to this block will 
be DF51-ARTH_XmlExchangeLog.xml. 
 
To view the XML files, go to the File menu and select the option Exchange XML Viewer to open 
the dialog box and select the XML file. See the example below: 
 

 
Figure 2.32. XML log files for blocks 

 
Select the icon of the desired file and click Open to open the XML Viewer window. 
 
If the selected XML file corresponds to a device or bridge exchange, the XML Viewer window 
shows the alterations made to the instrument in the configuration, that is, whether the device, blocks 
and parameters were replaced, and blocks and parameters that were removed. See the example 
below: 
 

 
Figure 2.33. XML Viewer Window 

 
If the selected XML file corresponds to a block, the XML Viewer window shows the alterations made 
when converting a SE area to a HSE area, indicating the blocks that were replaced in the new 
bridge and blocks that were deleted. 
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The left panel on the XML Viewer window shows the blocks and parameters configured in the 
original device before the Exchange procedure (or before converting the SE configuration). Select 
the icon of a block to see the details about block or parameter compatibility. 
 
The column Attribute shows the attributes of a selected block. The column Current shows the 
value of the attribute in the previous device and the column Alternative indicates the new value of 
the attribute, when there is a compliant parameter in the new device. 
 
The filter levels classify the compatibility of blocks and parameters attributes: 
 

 The attributes classified by this filter are compliant in the new device. 

 
The Low Severity filter indicates the attributes are not compliant but 
the information was not lost. 

 
The High Severity filter indicates the attributes are not compliant and 
the information was lost or converted. 

 This filter displays all attributes. 

 
Click Ok to close this window and return to Syscon. 
 
 
 
 



Section 3 
 

3.1 

PLANT CONFIGURATION 
 
An industrial plant can be divided in areas, which represent part of a process automation 
application. An area is initially divided in two main parts: the control application and the plant 
topology. 
 
The control application of an area, which contains links between function blocks to represent the 
control strategy, is organized in Process Cells, Units, and Control Modules. Process Cells are 
created to subdivide areas or processes of the plant. 
 
Batching activities are focused on Units. One or more major process activities can be conducted in a 
Unit, which is usually centered on a major piece of processing equipment, such as a mixing tank or 
reactor. 
 
Control Modules are created to configure the control strategy related to the areas or processes 
created in the Process Cells. 
 
The plant topology is represented by the fieldbus communication network and all field control 
instruments, such as controllers, linking devices, gateways, instruments, and field devices. Linking 
devices and gateways implement specific protocols to access the communication network 
corresponding to these protocols. 
 
Naturally, these two parts are related. The relation between them is the function block, which is 
present in both parts. Function blocks represent the automation functions, and they are the common 
elements between the control application and the plant topology. 
 
In the Syscon configuration, the control application was defined according to the ISA S88 model 
and the plant topology was defined according to the FF-581 and FF-890 models. 
 
Syscon was designed to make it possible to start a configuration from different points and go 
through different ways. For example, it is possible to configure the plant topology first, creating 
segments, devices and function blocks, and then attach the blocks to the control application. Or the 
user can first configure the control application creating the control strategy and, after that, create the 
topology and attach the function blocks previously created in the control application. 
 
 

IMPORTANT 

The Studio302 Database Manager manages all project configuration files, and the 
configurations created using Syscon are saved in a common storage directory where all 
machines connected to the communication network can access those files. 
It is important to have a common practice to name tags in your company, to avoid consistency 
problems. 
For example, in Multi-user mode, if User A creates a configuration in a machine with the same 
name that User B created the configuration in another machine, one of the configuration files will 
be deleted and overlaid by the other file, when the configurations are committed. Likewise, it will 
not be possible to type the same tag for two or more control modules (or devices, blocks, etc) in 
different project files. 

 
 

Area 
 
Changing the area attributes 
 
Right-click the area icon and click Attributes. The Area dialog box will open.  
 
Type the new tag and click Ok. 
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Figure 3.1. Area Attributes Dialog Box 

 

Process Cells 
 
Creating Process Cells 
 
To create a process cell, right-click the application icon and click New Process Cell. The Process 
Cell dialog box will open. Type the process cell tag and click OK. If you do not define the tag, 
Process Cell n will be the default tag, where n is a sequential number for process cells. 
 

 
Figure 3.2. Process Cell Dialog Box 

 
After creating the process cell, the main window will look like the following figure: 
 

 
Figure 3.3. Main Window 

 
The process cell has its own window. Right-click the process cell icon and click Expand, or double-
click the process cell icon: 
 

 
Figure 3.4. Process Cell Window 
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Changing Process Cell Attributes 
 
Right-click the process cell icon on the Process Cell window and click Attributes. The Process Cell 
dialog box will open. Type the new process cell tag and click Ok. 
 

 
Figure 3.5. Process Cell Dialog Box 

 
 
Deleting Process Cells 
 
Right-click the process cell icon and click Delete Process Cell. Or click to select the process cell 
icon and press the Delete key on your keyboard. 
 
A message box will open informing the user that the process cell and all units and control modules 
attached to it will be deleted from the strategy configuration. This operation cannot be undone! 
 
Click Yes to confirm the operation and delete the process cell or click No to cancel. 
 

ATTENTION 

If you confirm the operation, the process cell, units, and control modules will be removed from 
the strategy configuration and will not be sent to the Recycle Bin. I/O points are also deleted. 
Function blocks that are attached to devices are not removed from the strategy configuration. 

 
 

Units 
 
Creating Units 
 
Right-click the process cell icon on the Process Cell window and click New Unit. The Unit dialog 
box will open. Type the unit tag and click OK. 
 

 
Figure 3.6. Unit Dialog Box 

 
NOTE 

If you do not define a new tag, Unit n will be the default, where n is a sequential number for the 
units. 

 
 
Changing Unit Attributes 
 
The only attribute you can change for the unit is its tag. Right-click the unit icon and click Attributes. 
The Unit dialog box will open. Type the new tag and click Ok to conclude. 
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Figure 3.7. Unit Attributes Dialog Box 

 
 
Deleting Units 
 
To remove a unit from a process cell, right-click its icon and click Delete Unit. Or click to select the 
unit icon and press Delete on your keyboard. 
 
A message box will open informing the user that the unit and all control modules attached to it will 
be deleted from the strategy configuration. This operation cannot be undone! 
 
Click Yes to confirm the operation and delete the unit, or click No to cancel. 
 

ATTENTION 

If you confirm the operation, the unit, control module(s) attached to it and the related 
strategy(ies) will be removed from the strategy configuration and will not be sent to the Recycle 
Bin. I/O points are also deleted. Function blocks that are attached to devices are not removed 
from the strategy configuration. 

 
 

Control Modules 
 
Creating Control Modules 
 
A control module can be created attached to the process cell or attached to a unit, on the Process 
Cell window, according to the process you are building on your strategy configuration. 
 
Right-click the process cell icon, or the unit icon if it is the case, and click New Control Module. The 
Control Module dialog box will open. Type the control module tag and click OK. 
 

 
Figure 3.8. Control Module Dialog Box 

 
NOTE 

If you do not define a new tag, Control Module n will be the default, where n is a sequential 
number for the control modules. 

 
 
Changing Control Module Attributes 
 
To change the control module attributes, right-click its icon and click Attributes. The Control 
Module dialog box will open. 
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Figure 3.9. Control Module Attributes Dialog Box 

 
The Stale Count is the number of macrocycles used to signal that the data was not updated in the 
link. The Microcycle is the execution cycle for the control module, and its value is the same from the 
macrocycle. 
 
Type the new control module tag and click OK to close this dialog box. 
 
 
Deleting Control Modules 
 
To remove a control module, right-click its icon and click Delete Control Module. Or click to select 
the control module icon and press Delete on your keyboard. 
 
A message box will open informing the user that the control module and the related strategy will be 
deleted from the strategy configuration will not be sent to the Recycle Bin. This operation cannot be 
undone! 
 
Click Yes to confirm the operation and delete the control module, or click No to cancel. 
 
 
Moving Control Modules 
 
You can move control modules between units inside the same process cell, or move a control 
module to detach it from the unit and attach it to a process cell. 
 
Click to select the control module icon in the Process Cell window and drag the control module over 
the target icon: unit or process cell. 
 

ATTENTION 

It is not possible to move control modules between different Process Cell windows. 
 
 

Fieldbus Networks 
 
Creating a H1 or HSE Fieldbus 
 
Right-click the fieldbus networks icon and click New Fieldbus. The New Fieldbus dialog box will 
open. Select the communication type for the Fieldbus, H1 or HSE, type the tag and click OK to 
conclude. 
 

 
Figure 3.10. Fieldbus Dialog Box 
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IMPORTANT 

If the HSE type is selected, the HSE Host will be automatically added to the fieldbus channel 
and the HSE OLE Server will be automatically selected in the Communication Settings dialog 
box. 

 
If you do not define the tag, Fieldbus n will be the default tag, where n is a sequential number for 
the fieldbuses. The Fieldbus Networks do not have a direct correspondence to any of the existing 
process cells. 
 
The fieldbus has its own window, where you can create and edit devices, bridges and function 
blocks. Right-click the fieldbus icon and click Expand, or double-click the fieldbus icon. The 
Fieldbus window will open: 
 

 
Figure 3.11. Fieldbus Window 

 
 
Creating a Profibus Network 
 
It is necessary to add a Profibus controller to the HSE network to create a Profibus network (see 
section Creating a Controller for details). The DF73 module is the Smar solution for Profibus 
applications. The DF73 works as Profibus DP-HSE gateway to provide connectivity and flexibility to 
the system application. Using the HSE network and other DFI302 modules, field devices from 
different industrial protocols can communicate. 
 
On the main window, right-click the Profibus controller icon and click New Network. Type a tag and 
click Ok. There is only one communication port available for Profibus networks. 
 

 
Figure 3.12. Creating a Profibus Network 

 
The Network Configurator tool will automatically open to configure the network. Edit the master 
and slaves Profibus devices, save the configuration and close the Network Configurator tool. 
 
Return to Syscon and the Mapping Tool application will automatically open. Map the inputs and 
outputs according to your strategy configuration and click Ok to close and return to Syscon. Refer 
to the Tutorial: Mapping Tool from this manual for details about using the Mapping Tool. 
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Creating a DeviceNet Network 
 
It is necessary to add a DeviceNet controller to the HSE network to create a DeviceNet network (see 
section Creating a Controller for details). The DF79 module is the Smar solution for providing 
connectivity and flexibility between HSE networks and DeviceNet devices. 
 
Right-click the DeviceNet controller icon and click New Network. Type a tag and click Ok. There is 
only one communication port available for DeviceNet networks. 
 

 
Figure 3.13. Creating a DeviceNet Network 

 
The Network Configurator tool will automatically open to configure the network. Edit the master 
and slaves DeviceNet devices, save the configuration and close the Network Configurator tool. 
 
Return to Syscon and the Mapping Tool application will automatically open. Map the inputs and 
outputs according to your strategy configuration and click Ok to close and return to Syscon. 
 
 
Creating an AS-i Network 
 
It is necessary to add an AS-i controller to the HSE network to create a AS-i network (see section 
Creating a Controller for details). The DF81 module is the Smar solution for providing connectivity 
and flexibility between HSE networks and AS-i devices. 
 
Right-click the AS-i controller icon and click New Network. Type a tag and select the 
communication port, then click Ok. 
 

 
Figure 3.14. Creating an AS-i Network 

 
The AS-i Network Configuration Tool will automatically open to configure the network. Edit the 
master and slaves AS-i devices, save the configuration, and close the AS-i Network Configuration 
Tool. 
 
Return to Syscon and the Mapping Tool application will automatically open. Map the inputs and 
outputs according to your strategy configuration and click Ok to close and return to Syscon. 
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Creating a Modbus Network 
 
It is necessary to add a Modbus controller to the HSE network to create a Modbus network (see 
section Creating a Controller for details). The DF89 module is the Smar solution for providing 
connectivity and flexibility between HSE networks and Modbus devices. 
 
Right-click the Modbus controller icon and click New Network. Select the type of your Modbus 
network: Serial or TCP. Type a tag and click Ok. When you select the type of network, the 
communication port is automatically selected. 
 

 
Figure 3.15. Creating a Modbus Network 

 
The Smar Network Configuration - Modbus tool will automatically open to configure the network. 
Edit the devices, insert the commands, save the configuration, and close the SmarNetConf - 
Modbus. 
 
Return to Syscon and the Mapping Tool application will automatically open. Map the inputs and 
outputs according to your strategy configuration and click Ok to close and return to Syscon. 
 
 
Importing a Profibus or DeviceNet Configuration 
 
You can import a Profibus or DeviceNet network configuration created using the Network 
Configurator tool to your Syscon strategy configuration. 
 
Right-click the Profibus or DeviceNet controller icon and click Import Configuration. Locate the 
folder where the network configuration file is located, select the file icon and click Open. Then, type 
a related tag and click Ok. 
 
The Mapping Tool application will automatically open. Map the inputs and outputs according to 
your strategy configuration and click Ok to close and return to Syscon. 
 
 
Changing the H1 or HSE Fieldbus attributes 
 
Open the Fieldbus window, right-click the fieldbus icon and click Attributes. The Fieldbus dialog 
box will open. 
 



Plant Configuration 
 

3.9 

 
Figure 3.16. Fieldbus Dialog Box 

 
Type the new fieldbus tag. You can also select the Upstream Port for H1 fieldbuses. For Profibus 
networks, you can only change the fieldbus tag. 
 
Also, you can indirectly adjust the time dedicated to the Background Traffic by setting the 
macrocylce. The Background Traffic (in ms) will affect the refreshing time of the variables under 
supervision. The minimum value is 100ms. 
 
To set the macrocycle, type the new value and click Override. The values for the Background 
Traffic and the Foreground Traffic are calculated. Click Ok to accept these values and conclude 
this task. 
 
In case you need to restore the macrocycle to the default value, click Default and then click Ok. 
 
After clicking Override or Default (before closing the Fieldbus dialog box) the previous value of the 
macrocycle can be restored. Click Cancel to close the dialog box without applying the changes to 
the fieldbus. All modifications will be discarded, and all fieldbus parameters will be restored to the 
initial state. 
 

IMPORTANT 

Once configured by the user and validated by the Syscon automatic calculation, the value of the 
macrocycle will not be altered by the application tool, except when there is a significant alteration 
in the strategy configuration, such as when the user deletes or adds function blocks or links to a 
fieldbus channel. 
Every time the configuration is altered, Syscon automatically calculates the value of the 
macrocycle and if the result is higher than the value previously configured by the user, Syscon 
will automatically overwrite the user’s value with the new value of the macrocycle. 
For some bridges, the macrocycle standard value calculated by Syscon is not enough for stable 
operation of the device and good response to monitoring and supervision. In these cases, there 
is a minimum value and a desired maximum value for the macrocycle that can be defined in the 
Capabilities File related to the bridges. 
Syscon compares the standard value, the values defined on the Capabilities File and the value 
defined by the user (if this value exists), dynamically. The biggest value among these values will 
be applied to the macrocyle. 

 
 
Modifying the Profibus, DeviceNet, AS-i or Modbus configuration 
 
Open the Profibus or DeviceNet window, right-click the corresponding icon and select Modify 
Configuration. The Network Configurator tool will automatically open to configure the network. 
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To modify the AS-i fieldbus configuration, right-click the AS-i fieldbus icon and select Modify 
Configuration. The AS-i Network Configuration Tool will automatically open to configure the 
network. 
 
To modify the Modbus configuration, right-click the Modbus network icon and select Modify 
Configuration. The SmarNetConf - Modbus tool will automatically open to configure the network. 
 
When you finish editing, save the configuration, and close the configurator. 
 
Return to Syscon and the Mapping Tool application will automatically open. Map the inputs and 
outputs according to your strategy configuration and click Ok to close the Mapping Tool and return 
to Syscon. Refer to the Tutorial: Mapping Tool for details about using the Mapping Tool. 
 
 
Deleting Fieldbuses 
 
On the main window, right-click the fieldbus icon and click Delete Fieldbus, or press Delete on the 
keyboard. 
 
The Warning dialog box will appear. Click Yes to confirm the operation. 
 

NOTE 

If you confirm the operation, the fieldbus and the devices attached to the fieldbus will be 
removed from the strategy configuration and will not be sent to the Recycle Bin. 

 
 

Controllers 
 
Controllers can only be added to the HSE Fieldbus. 
 
Creating a controller 
 
On the HSE Network window, right-click the fieldbus icon and click New > Controller. The New 
Controller dialog box will open. 
 

 
Figure 3.17. Fieldbus Dialog Box 

 
Select the Manufacturer from the list and the Type provided by the selected manufacturer. Select 
the Device Revision. Then, select the DD Revision and the CF Revision. 
 
If the option Follow the Latest DD/CF Revision is selected, Syscon will update the controller with 
the latest revision of the DD and CF every time you open the configuration file. 
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Type a related tag for the controller. If you do not define the tag, Controller n will be the default tag, 
where n is a sequential number for controllers. 
 
At the Advanced Options tab, select the options to automatically create and configure blocks, 
parameters, and internal links, according to the Capabilities File. 
 
Click Ok to add the controller to the configuration. 
 
 
Creating the Controller from a Template 
 
On the HSE Network window, right-click the fieldbus icon and click New > Controller from 
Template. 
 
Select the directory where the template file is located, select the controller template file and click 
Open. A message box will open to confirm the operation. Click Ok to proceed. 
 
The Tag Table will open, showing the list of blocks with the tags based on the preferences settings 
and the old tags used in the template file. To edit a tag, right-click the icon at the New Tag column 
and click Rename. Type the new tag and press Enter on the keyboard. 
 
Click Ok to close the Tag Table dialog box and add the controller to the configuration. 
 
 
Changing the controller attributes 
 
Right-click the controller icon and select Attributes. 
 
The only attribute you can change is the controller tag. Type the new tag for the controller and click 
Ok to conclude. 
 
 
Adding Redundancy to the controller 
 
While creating the controller, select the option Is Redundant to indicate the controller is redundant. 
If the controller was already created in the configuration, right-click the controller icon and select 
Attributes. Select the option Is Redundant and click Ok. 
 
Then, right-click the controller icon again and select the option Commission. Verify the information 
about the controller and click Ok to commission. Open the Controller Attributes dialog box again 
and select the Redundancy tab. Syscon automatically configures the backup serial number. 
 
Consult the DFI302 User’s Manual for details about redundancy for controllers. 
 
 
Deleting a controller 
 
Right-click the controller icon and click Delete, or press Delete on the keyboard. The Warning 
dialog box will appear. Click Yes to confirm the operation. 
 
 

Bridges 
 
Use bridges when a block should supply a value to another block, but these blocks are inside 
different fieldbus links. 
 
Creating Bridges 
 
Right-click the fieldbus icon on the Fieldbus window and click New > Bridge. The New Bridge 
dialog box will open: 
 

1. Select the Bridge Manufacturer from the list. 

2. Select the Type provided by the selected manufacturer. 
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3. Select the Device Revision, then select the DD Revision and the CF Revision, or check 
the option Follow the Latest DD/CF Revision to apply the latest revision for the selected 
bridge. 

ATTENTION 

If the option Follow the Latest DD/CF Revision is selected, Syscon will update the bridge with 
the latest revision of the DD and CF every time the configuration file is opened. To disable the 
automatic update, right-click the bridge icon, click the option Exchange and unmark that option 
on the Exchange dialog box. 

4. Type a related tag for the bridge. If you do not define the tag, Bridge n will be the default 
tag, where n is a sequential number for the bridges. 

5. Select the upstream port to connect the bridge to the communication channel. 

6. At the Advanced Options tab, select the option to automatically create and configure 
blocks, parameters, and internal links according to the Capabilities File or based on the 
Default Template file for the selected Device Revision, located in the corresponding 
Device Support folder. 

NOTE 

If the Default Template file is not found, Syscon will automatically create the Resource and 
Transducer Blocks for the selected bridge. 

7. Click Ok to add the bridge to the configuration. 

IMPORTANT 

The HSE Host, linking devices and I/O Gateways can only be added to the HSE Fieldbus. 
Likewise, the H1 Bridge can only be added to the H1 Fieldbus. 

 
 
Creating a Bridge from a Template 
 
To create a bridge based on a Bridge Template File, right-click the fieldbus icon on the Fieldbus 
window and click New > Bridge from Template. 
 
Select the directory where the template file is located, select the bridge template file, and click 
Open. A message box will open to confirm the operation. Click Ok to proceed. 
 
The Tag Table will open, showing the list with block and bridge tags based on the preferences 
settings and the old tags used in the template file. To edit a tag, right-click the block or bridge icon at 
the New Tag column and click Rename. Type the new tag and click Enter on the keyboard. 
 
Click Ok to close the Tag Table dialog box and add the bridge to the configuration. 
 
 
Changing Bridge Attributes 
 
Right-click the bridge icon and click Attributes. The Bridge Attributes dialog box will open. 
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Figure 3.18. Bridge Attributes Dialog Box 

 
You can change the bridge tag and configure the redundancy for HSE networks. Click Ok to 
conclude. 
 

ATTENTION 

To disable the automatic update configured with the option Follow the Latest DD/CF Revision, 
use the Bridge Exchange procedure: right-click the bridge icon, click Exchange and unmark 
that option on the Exchange dialog box. 

 
 
Deleting Bridges 
 
To remove a bridge, right-click its icon on the Fieldbus window and click Delete Bridge, or press 
Delete on the keyboard. 
 
The warning dialog box will open. Click Yes to confirm the operation. 
 

IMPORTANT 

If the bridge has blocks with External Links, it will be necessary to delete the links before deleting 
the bridge. 

 
 
Adding Redundancy to the HSE Bridge 
 
There are three possible ways to add redundancy to the HSE bridge using Syscon: adding 
redundancy while creating the bridge, editing the bridge attributes or changing to online mode when 
a switch over occurs in the active CPU. 
 
 
Mode 1: Adding redundancy while creating the bridge 
 
In this case, the redundancy is configured when the user is creating the HSE bridge. Follow the 
procedure described in section Creating Bridges to create the HSE Bridge and on the New Bridge 
dialog box, select the option Is Redundant as indicated in the figure below. 
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Figure 3.19. Add redundancy while creating the bridge 

 
 
Mode 2: Editing the bridge attributes 
 
In this case, the redundancy will be configured by editing the bridge attributes after creating the HSE 
bridge in Syscon. 
 
Right-click the bridge icon and click Attributes to open the Bridge Attributes dialog box. Select the 
option Is Redundant as indicated in the figure below. 
 

 
Figure 3.20. Editing the bridge attributes to add redundancy 

 
The Redundancy tab will appear after checking the redundancy option. Click Ok to close the 
Bridge Attributes dialog box. 
 
Commission the bridge. Right-click the bridge icon and click Commission. Verify the information 
about the HSE bridge, select the Device ID and click Ok to commission this bridge. 
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Open the Bridge Attributes dialog box again and select the Redundancy tab. The serial number of 
the backup bridge will be displayed in the Alternative Device ID field. Syscon automatically 
configures this serial number. See the following figure: 
 

 
Figure 3.21. Redundancy tab 

 
NOTE 

When Syscon is online and the user marks the redundancy option in the Bridge Attributes 
dialog box, the Device ID field will indicate the serial number of the Active Bridge and the 
Alternative Device Id field will indicate the serial number of the Backup Bridge. 

 
 
Mode 3: Setting the redundancy after a switch over 
 
In this case, the redundancy is configured while the system is operating in the online mode because, 
for example, although the hardware may have been installed with redundancy, the user did not set 
the redundancy parameter for the HSE Bridge in the strategy configuration. 
 
After a failure occurs in the Active Bridge, the system will identify a Backup Bridge. The following 
message will appear prompting the user to configure the redundancy. 
 

 
Figure 3.22. Configuring the bridge as redundant 

 
Click Yes to configure the redundancy. If you click No, the message above will not appear again 
and Syscon will assume that the bridge is not redundant. 
 
 
Connecting a Bridge to a Fieldbus 
 
Note the following situation: 
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Figure 3.23. Main Window 

 
In this example, a H1 fieldbus segment was added to the configuration but this channel is not 
connected to any bridge. 
 
To enable the communication to this channel, right-click the bridge icon on the main window and 
click Connect to. The Connect Bridge to dialog box will open. Select the fieldbus segment in the 
Tag box and the port to connect the fieldbus in the Upstream Port. Click Ok to conclude. 
 

 
Figure 3.24. Connect Bridge Dialog Box 

 
NOTE 

If you are connecting the bridge to a HSE fieldbus, the Upstream Port field may not be active, 
because there is only one HSE port in the bridge and it may have been already connected. 

 
The following figure shows the plant topology after the connection: 
 

 
Figure 3.25. Main Window 
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Disconnecting a Bridge from a Fieldbus 
 
To disconnect a fieldbus segment from a bridge channel, right-click the bridge icon and click 
Disconnect from. The Disconnect Bridge from dialog box will open. Select the fieldbus in the 
Fieldbus box and click Ok. 
 
 
Bridge Exchange 
 
The procedure to exchange a bridge is the same as described in section Device Exchange further 
ahead. Please refer to this section for further information. 
 
 

Devices 
 
Creating Devices 
 
On the Fieldbus window, right-click the fieldbus icon and click New > Device. The New Device 
dialog box will open. 
 
Select the Device Manufacturer from the list and the Device Type provided by the selected 
manufacturer. 
 
Select the Device Revision, then select the DD Revision and the CF Revision, or check the option 
Follow the Latest DD/CF Revision to apply the latest revision for the selected device. 
 

NOTE 

If the option Follow the Latest DD/CF Revision is selected, Syscon will update the device with 
the latest revision of the DD and CF every time the configuration file is opened. To disable the 
automatic update, right-click the device icon, click Exchange and unmark that option on the 
Exchange dialog box. 

 
Type a related tag for the device. If you do not define the tag, Device n will be the default tag, where 
n is a sequential number for devices. 
 

 
Figure 3.26. Device Dialog Box 

 
At the Advanced Options tab, select the options to automatically create and configure blocks and 
parameters, according to the Capabilities File: 
 

• Creation Based on Default Template: creates the device based on the Default 
Template file for the selected Device Revision, located in the corresponding Device 
Support folder. 

• Create Resource Block: automatically creates the Resource Block of the selected 
device. You can set the initial value for the Mode Block parameter. 

• Create Transducer Blocks: automatically creates the Transducer Blocks of the 
selected device. You can set the initial value for the Mode Block parameter. 
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Figure 3.27. Advanced Options 

 
Click Ok to add the device to the configuration. 
 

NOTE 

If the Default Template file is not found, Syscon will automatically create the Resource and 
Transducer Blocks for the selected device. 

 
IMPORTANT 

The HSE Device can only be added to the HSE Fieldbus. Likewise, the H1 Device can only be 
added to the H1 Fieldbus. 

 
 
Creating a Device from a Template 
 
On the Fieldbus window, right-click the fieldbus icon and click New > Device from Template. 
 
Select the directory where the template file is located, select the device template file and click Open. 
A message box will open to confirm the operation. Click Ok to proceed. 
 
The Tag Table will open, showing the list with block and device tags based on the preferences 
settings and the old tags used in the template file. To edit a tag, right-click the block or device icon 
at the New Tag column and click Rename. Type the new tag and click Enter on the keyboard. 
 

 
Figure 3.28. Tag Table dialog box 

 
Click Ok to close the Tag Table dialog box and add the device to the configuration. 
 



Plant Configuration 
 

3.19 

Changing the Device Attributes 
 
Right-click the device icon and click Attributes. The Device Attributes dialog box will open. 
 

 
Figure 3.29. Device Attributes Dialog Box 

 
You can type a new tag for the device and select the BOF class. 
 

ATTENTION 

To disable the automatic update configured with the option Follow the Latest DD/CF Revision, 
right-click the device icon, click Exchange and unmark that option on the Exchange dialog box. 

 
When operating in the Advanced User mode, the tab Advanced Options will be available in the 
Device Attributes dialog box. Type the new physical address for the device. 
 

 
Figure 3.30. Advanced Options 

 
It is recommended to execute the normal commissioning operation using the options Commission 
(see section Commissioning a Device) and Decommission (see section Decommissioning a 
Device). Only for some engineering and test scenarios, using Syscon in Advanced Mode, it is 
possible to delete the Device Id from the instrument without using the decommissioning procedure. 
 
Click Clear to delete the Device Id. This procedure do not replace the option Decommission, it only 
disassociates the physical instrument from the instrument on the configuration. 
 
Click Ok to apply the alterations and conclude. 
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Master Backup Device 
 
To configure the device to operate as a Master Backup, a Link Master should be selected. 
 
Right-click the device icon and click Attributes. Click the down arrow of the BOF Class box and 
select the option Link Master. 
 
Click Ok to conclude. 
 

 
Figure 3.31. Configuring the Link Master Device 

 
NOTE 

When Syscon is online, the option Change BOF Class is available on the device menu. Right-
click the device and click Change BOF Class. 

 
 
A message box will inform that it is necessary to reinitialize the device. Reset the device and 
execute the Download Schedule in the channel where the device is configured: right-click the 
fieldbus icon and select Download Schedule. 
 
After the download, the device will operate as a Link Master. 
 

NOTE 

During the download, all Master Backups in the Fieldbus Network will be configured with the 
Traffic Schedule. 

 
 
Deleting Devices 
 
To remove a device from the Fieldbus window, right-click its icon and click Delete, or press Delete 
on your keyboard. 
 
The warning dialog box will appear. Click Yes to confirm the operation. 
 
 
Ordering Devices 
 
Select a device icon and drag it over the other device icon. The selected device will be placed above 
the other device in the configuration tree. 
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Figure 3.32. Ordering Devices in the Fieldbus Window 

 
 
Moving Devices 
 
To move a device from one fieldbus to another, click to select the device icon in the Fieldbus 
window and drag the device over the other Fieldbus window. 
 
If there are any block links connecting the device to its original Fieldbus window, these links may no 
longer be available for the communication, because no valid path would be found in the topology. 
The unrealized links will be identified by a dotted line in the Strategy window. 
 

 
Figure 3.33. Moving a Device 

 
 
Device Exchange 
 
When a defective device must be replaced by a new device that has a newer or different Device 
Revision, it is possible to exchange these devices easily without modifying the existing 
configuration. You can also use the Exchange procedure to change the Device Revision of the 
device. 
 
The Device Exchange verifies the inconsistencies, incompatibilities, and interchangeability 
problems, and generates a report about the changes that will affect the configuration. 
 
To exchange a device, right-click its icon and click Exchange. The Exchange dialog box will open: 
 

ATTENTION 

If a device has Flexible Function Blocks (FFB) configured using the Define Parameters 
procedure, the device can be replaced by a compatible device using the Exchange procedure. 
But if the new device has FFB, it will not have defined parameters. 
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Figure 3.34. Device Exchange Dialog Box 

 
You can change the Manufacturer, the Device Type and the Device Revision. Edit the attributes and 
click Ok. 
 
Syscon will compare the new device capabilities with the previous device capabilities and display 
the incompatibilities at the Device Exchange Deviations dialog box. 
 
The Deviations dialog box shows detailed information about the device, blocks and parameters, 
indicating to the user the functionalities that can be lost when exchanging the device. See the 
example below: 
 

 
Figure 3.35. Device Deviations Dialog Box 

 
The panel on the left shows the blocks and parameters configured in the original device and 
indicates the compatibility to the new device. 
 
The panel on the right compares the attributes of the original device to the new equipment selected. 
Click the column headers (Attribute, Current, Alternative, Severity or Index) to sort the list of 
parameters. Clicking the column header will also toggle between ascendant and descendent sorting. 
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The Deviations dialog box has its own toolbar. The following table describes the functionalities of 
the buttons: 
 

 Click this button to refresh the information on the dialog box. 

 Click this button to expand all nodes. 

 Click this button to collapse all nodes. 

 Click this button to accept the changes and close the Deviations dialog box. 

 
Click this button to cancel the Exchange procedure and close the 
Deviations dialog box. 

 Click this button to open the Syscon Online Help. 

 
The Deviations dialog box has four filter levels that classify all of the blocks and parameters 
attributes for the device: 
 

 The attributes classified by this filter are compliant with the device. 

 
The Low Severity filter indicates that the attributes are not compliant but the 
information won't be lost. 

 
The High Severity filter indicates that the attributes are not compliant and the 
information can be lost or converted. 

 This filter will display all attributes. 

 
Click Ok to confirm the Exchange procedure. Syscon will verify the compatibility of the blocks. If a 
block is not available in the target device, a dialog box will open alerting the user that 
inconsistencies were detected, and some functionalities will be lost if the device is exchanged. 
 

 
Figure 3.36. Detecting Inconsistencies 

 
Click Yes to confirm the exchange or click No to cancel the procedure and discard the device 
alterations. 
 
If you confirm the Exchange procedure, the Compatibility dialog box will open. The Compatibility 
dialog box allows you to replace the blocks from the previous device that are not compatible with the 
new device. See the example below: 
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Figure 3.37. Compatibility Dialog Box 

 
The panel on the left indicates the blocks that are not compatible with the new device. For each 
block not compatible, click its icon and the panel on the right will show the types of the compatible 
blocks. 
 
Use the buttons in the toolbar to filter the blocks: 
 

 
This filter shows the list of blocks from the new device, which are compatible to the 
blocks from the previous device. 

 
This filter shows the list of blocks from the new device, which are not compatible to the 
blocks from the previous device. 

 
Right-click the icon of the compatible block and click Enable to replace the old block in the device. 
 

 
Figure 3.38. Selecting a compliant block 

 
Repeat this procedure for each block that is not compatible with the new device. Click Ok to confirm 
the alterations and close the Compatibility dialog box. 
 
Blocks that cannot be converted will be removed from the configuration and sent to the Recycle 
Bin. Parameters cannot be converted. If there is no identical parameter in the new device, the 
parameter will be deleted and will not be sent to the Recycle Bin. 
 
Syscon checks if the device being exchanged has trends attached to it, and if there is any, Syscon 
checks if the parameter the trends were based on were removed. If the parameter were deleted in 
the Exchange procedure, the trends will also be deleted. 
 

ATTENTION 

For each replaced bridge or device, Syscon creates a log file in XML format that contains the 
discrepancies between the instruments. This XML file is stored in the project folder 
corresponding to the current configuration. 
To view the XML file, go to the File menu and select the option Exchange XML Viewer. Select 
the desired XML file and the XML Viewer window shows the alterations made in the Exchange 
procedure, that is, whether the device (or bridge), blocks and parameters were replaced or not, 
and blocks and parameters that were removed. 
Refer to subsection Using the XML Viewer Window in Section 2 for further details about the 
XML Viewer window. 
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Function Blocks 
 
Creating Blocks in the Control Module 
 
Right-click the control module icon on the Process Cell window and click New Block. The New 
Block dialog box will open. 
 
Select the Block Manufacturer from the list, and then select the Device Type provided by the 
manufacturer. 
 
Syscon uses the latest revision of the Device Revision, the DD Revision and the CF Revision as the 
default values for the new block. Change these values according to the device being used in the 
plant and its revision. 
 
Select the Block Type and type a related tag for the block. If the tag is not typed, the tag will be 
generated according to the Preferences Settings of the current configuration. 
 
Click OK to conclude. 
 

 
Figure 3.39. New Block Dialog Box 

 
 
Creating Blocks in the Device 
 

Click the device expansion sign  to select the VFD icon. Then, right-click the VFD icon and click 
New Block. The New Block dialog box will open. 
 
Select a block type and type a related tag for the block. If a new tag is not typed, the tag will be 
generated according to the Preferences Settings of the current configuration. 
 
Click OK to conclude. 
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Figure 3.40. New Block Dialog Box 

 
NOTE 

The Resource Block and the Transducer Blocks can only be created in the devices or bridges, 
and they have a different representation from the other blocks. Resource and Transducer Blocks 
cannot be moved or attached to the control module or the Strategy window. 
When converting a configuration file from an older version, the Resource and Transducer Blocks 
will be deleted from the control module and the Strategy window. 

 
 
Changing Block Attributes 
 
The tag is the only block attribute that can be changed. 
 
Right-click the block icon and click the option Attributes. Edit the tag and click Ok to conclude. 
 

 
Figure 3.41. Block Attributes Dialog Box 

 
 
Deleting Blocks 
 
Right-click the block icon and click Delete Block, or press the Delete key on the keyboard. 
 
The warning dialog box will open. Click Yes to confirm the operation. 
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IMPORTANT 

When deleting a block from the control module, the block is removed from the device too, and 
vice-versa, even if it is attached to a fieldbus or drawn at the Strategy window. The block will be 
sent to the Recycle Bin and can be restored to the area if its original fieldbus or control module 
is not deleted. 
If the block being deleted has any trend associated to it, Syscon will also delete the trends but 
only the block will be sent to the Recycle Bin. Restoring the block to the configuration later on 
will not restore any trend. 
Deleting a FFB (Flexible Function Block) will remove it from the control module and the device, 
but the FFB will not be sent to the Recycle Bin. 
Blocks from Profibus and DeviceNet devices cannot be deleted from the device; they can only be 
deleted from the Strategy window and detached from the control module. 

 
 
Attaching Blocks to the Control Module 
 
A block can be attached to the control module after being added to the device. 
 
On the Process Cell window, right-click the control module icon and click Attach Block. The Attach 
Block dialog box will open. 
 
Select the block from the list and click Ok to conclude. 
 

 
Figure 3.42. Attach Block Dialog Box 

 
Another easy way to attach blocks to the control module is dragging them from the Fieldbus window. 
Click the block icon on the Fieldbus window and hold the mouse button while dragging the block 
over the control module icon on the Process Cell window, then release the mouse button. 
 
You can also click the block icon and drag it to the Strategy window. Once you release the mouse 
button, the block will be attached to the control module at the same time that it is drawn on the 
Strategy window. 
 
 
Detaching Blocks from the Control Module 
 
A block can only be detached if it exists in the control module and in the device. On the Process Cell 
window, right-click the block icon and click Detach Block. 
 
The warning dialog box will open. Click Yes to detach the block. 
 
The block is removed from the control module but it still exists on the area, attached to a device. 
 
 
Attaching Blocks to the Device 
 
If at least one block has been added to the control module, or to another device, that block can be 
attached to the device. 
 

On the Fieldbus window, click the expansion sign  of the device, right-click the VFD icon and 
click Attach Block. The Attach Block dialog box will open. Select the block from the list and click 
OK to conclude. 
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Figure 3.43. Attach Block Dialog Box 

 
Another easy way to attach blocks to the device is dragging them from the Process Cell window. 
Click the block icon on the Process Cell window and hold the mouse button while dragging the block 
over the VFD icon on the Fieldbus window, then release the mouse button. 
 
If the block being attached is not compliant with the target device, for example, device of a different 
type or with a different Device Revision, a message box will open alerting the user to search for a 
compatible block. 
 

 
Figure 3.44. Block Inconsistencies 

 
Click Yes on this message box and the Block dialog box will open: 
 

 
Figure 3.45. Selecting a Compliant Block 

 
Select Show Compliant With Blocks to display the list of compatible types of blocks available in 
the target device, or select Show All Available Blocks to display the list of all types of blocks 
available in the target device. 
 
Then, select the block type from the list and click Ok to accept the changes. 
 

NOTE 

When you are exchanging a device and the procedure for selecting a compliant block is 
canceled, the block is deleted from the device. If this block is not attached to a control module, it 
will be sent to the Recycle Bin. 

 
The Deviation dialog box will open. Analyze the differences between the original block and the new 
block and click Ok to accept the changes. See the example below: 
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Figure 3.46. Block Deviations Dialog Box 

 
 
Detaching Blocks from the Device 
 
A block can only be detached if it exists in the control module and in the device. On the Fieldbus 
window, right-click the block icon and click Detach Block. 
 
The warning dialog box will open. Click Yes to confirm the operation. 
 
The block is only removed from the device but it still exists on the area, attached to a control 
module. 
 
Blocks from Profibus and DeviceNet devices cannot be detached from the device. 
 
 
Moving Blocks 
 
You can drag a block from one control module to another, from one device to another, in the same 
Process Cell or Fieldbus window or between different windows. This procedure is similar to the 
Attach Block procedure. 
 
Before dragging a block from one window to the other, remember to tile the windows to facilitate the 
process. In the Window menu, click Tile. 
 

NOTE 

When a block is moved between control modules or devices, its tag will be updated according to 
the Preferences set by the user. To prevent undesired changes, select the option Default for 
the automatic block tag generation in the Preferences dialog box. 

 
If the block is moved to a device of a different type or with a different Device Revision, this block 
may not be available in the target device. In this case, a message box will open alerting the user to 
search for a compatible block. See section Attaching Blocks to the Device. 
 
 
Ordering Blocks 
 
The blocks can be organized only in the Fieldbus window to define the download sequence. The 
download sequence can also be defined ordering devices and parameters on the Fieldbus window. 
 
Select the block icon and drag it over another block icon. The selected block will be placed above 
the other one on the configuration tree. 
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Figure 3.47. Ordering Blocks at the Fieldbus Window 

 
 
Off Line Characterization 
 
You can configure the value of the parameters in the Characterization dialog box. 
 

ATTENTION 

If Syscon is operating in offline mode, double-click the block icon to open the Off Line 
Characterization dialog box. When Syscon is in online mode, double-clicking the block icon 
will open the On Line Characterization dialog box. 

 
Select the block to be parameterized, right-click its icon and click Off Line Characterization. 
 

 
Figure 3.48. Off Line Characterization Dialog Box 

 
You can sort the parameters by clicking the column header on the Off Line Characterization dialog 
box. Clicking the column header will toggle between ascendant and descendent sorting. 
 
On the Characterization toolbar, click to list all parameters or click to list the parameters defined by 
type. See section Customizing the Parameters List. 
 
Right-click the area at the bottom of the Characterization dialog box to open the menu and select 
specific types of parameters and non-default columns to be displayed in this dialog box. See section 
Characterization Toolbar for details. 
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To edit the value of the parameter, click its line and click the button Edit at the bottom of the 
Characterization dialog box. After editing the Value column, click the button End Edit to confirm 
the changes to the parameter. If the values edited into the parameter are incorrect or don’t have to 
be changed, click Cancel Edit and they will return to the previous value. 
 
Click Clear to clear the value typed for the highlighted parameter. If the parameter is not part of a 
link in the Strategy window, it will be removed from the configuration. 
 
After finishing editing the parameters, click Close to exit the Characterization dialog box. 
 
For further information about the parameter from the blocks manufactured by SMAR, please refer to 
the Function Blocks Instruction Manual. 
 
 
On Line Characterization 
 
The Online Characterization changes the block parameter values directly in the devices. 
 

ATTENTION 

Syscon must be in online mode, but if the communication is not online, you can click the option 
On line Characterization from the block menu and the communication will be initialized only for 
the selected block. 

 
If Syscon is communicating to the plant, right-click the block icon and click On Line 
Characterization. The On Line Characterization dialog box will open. 
 

 
Figure 3.49. On Line Characterization Dialog Box 

 
Use the same procedure described above for the Off Line Characterization to edit the parameters 
values. If any parameter is altered, the changes are also applied in the corresponding device. 
 
The parameters that were edited will be marked with a V in the Changed column. 
 
To save a parameter value that has not been edited, click the button Mark to save  on the 
Characterization toolbar. The parameter will be marked with a V in the Changed column. Or use 
the Mark to save button to unmark a parameter whose value has been changed but the changes 
are not to be saved. 
 
The CF Default Value column shows the default parameter values defined by the device 
manufacturer in the Capabilities File. To apply the default value to a parameter, select the 
parameter in the On Line Characterization dialog box and click the button Set Default. The button 
Set Default is only available in the On Line Characterization dialog box and for parameters 
defined as read/write. 
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Click Close to exit the Characterization dialog box, and the following dialog box will open: 
 

 
Figure 3.50. Save Parameters Dialog Box 

 
Click Yes to save the changes to the configuration file and close the Characterization dialog box. 
 
 

Flexible Function Blocks 
 
Syscon 6.5 supports new data types for Flexible Function Blocks to optimize HSE links between 
blocks. Syscon indicates the different FFB versions and revisions to verify the configuration 
consistency. 
 

IMPORTANT 

Do not add FFBs and HC blocks to the same bridge. Otherwise, it will cause a conflict in the 
LogicView configuration. Refer to the LogicView User’s Manual for further information on how to 
create FFB templates and logics. 

 
 
Creating Flexible Function Blocks 
 
Right-click the FB VFD icon of the bridge and click the option New Block. The New Block dialog 
box will open. 
 
Select the type of the FFB from the list and type a related tag for the block. If you do not type the 
tag, the tag will be generated according to the Preferences Settings of the current configuration. 
 
Click Ok to conclude. The FFB will be automatically created with its pre-defined number of inputs 
and outputs. 
 
 
Defining Parameters for the Flexible Function Block 
 
Right-click the FFB icon and click Define Parameters. The FFB Parameters Definition dialog box 
will open. 
 

ATTENTION 

It is not possible to define parameters for the FFB if the FFB is not attached to a device in the 
strategy configuration. The option Define Parameters will be disabled in the FFB popup menu. 
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Figure 3.51. Defining Parameters 

 
You can select the number of input and output parameters on the FFB Parameters Definition 
dialog box, but the FFB is initially created with a pre-defined number of points, indicated by the 
options Single I/O and Multiple I/O. For further information about Flexible Function Blocks, please 
refer to the Function Blocks Instruction Manual - Library B. 
 
Each parameter for each block is displayed with the related tag, which can be the tag defined by the 
user or the default tag, in case the user did not edit the tags. Refer to the section Editing 
Parameter Tags, in the Parameters section below, for details. 
 
The Define Parameters tool indicates the status of the FFB inputs and outputs, according to their 
icons: 
 

 Not Used Parameter is not being used and can be edited. 

 Used in LogicView 
Parameter is associated in a FFB logic used in LogicView 
and the tag is not available for edition. 

 Used in Syscon 
Parameter is being used in the control module in Syscon and 
the tag is not available for edition. 

 Used in LogicView 
and Syscon 

Parameter is being used in the control module in Syscon and 
it is associated in a FFB logic used in LogicView. The tag is 
not available for edition. 

 Used in Area Link 
Parameter is being used in Area Link Tool. The tag is not 
available for edition. 

 
To edit the parameters that are being used in a control module or logic, and therefore were not 
available for edition, click the button Change IO Quantity. A message box will warn you that the 
Define Parameters tool will unlock the inputs and outputs for edition. 
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Figure 3.52. Editing used tags 

 
Click Yes to continue and the status of the I/O points will change to Not Used . 
 

ATTENTION 

Editing tags that were already being used in LogicView or Syscon may cause inconsistencies. 
Blocks links may be removed from Syscon or variables may be deleted from the FFB internal 
logic. 

 
After editing the parameters, click Ok in the FFB Parameters Definition dialog box and a warning 
box will open. 
 

 
Figure 3.53. Confirming the alterations 

 
Click Yes to save the changes and the links between the parameters are automatically included in 
the configuration file. 
 
In that warning box, click No to return to the FFB Parameters Definition dialog box and continue 
editing the parameters. If you click Cancel, the FFB Parameters Definition dialog box will be 
closed and the changes will be discarded. 
 

NOTE 

It is recommended to download the configuration to the bridge or controller where the modified 
FFB is attached to prevent inconsistencies in the plant. 

 
 
Viewing and Editing the Logic for the Flexible Function Block 
 
To view the ladder logic associated to the FFB, right-click the FFB icon and select the option View 
Logic. The LogicView for FFB application will open in View Mode and no alterations can be made. 
 
To create or edit the logic for the FFB, right-click the FFB icon and select the option Edit Logic. The 
LogicView for FFB application will open the FFB configuration to be edited. Edit the configuration 
and save the alterations. 
 

ATTENTION 

If the logic is being edited by any user, the option Edit Logic will not be available. 
 
Close the LogicView application to return to Syscon. 
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Refer to the Logic View User’s Manual for further information on how to edit the logic for the 
Flexible Function Block. 
 
 
Replacing Flexible Function Blocks 
 
To replace the FFB included in the strategy configuration by another FFB template, right-click the 
FFB icon and click Replace. The Replace FFB dialog box will open. 
 

ATTENTION 

A FFB cannot be replaced if it is not attached to a device in the strategy configuration. The option 
Replace will be disabled in the FFB popup menu. 

 
Click the template name in the list of templates available and the information related to the 
manufacturer, the device and the configured parameters will be displayed. The block tag cannot be 
changed. 
 

 
Figure 3.54. Replacing FFBs 

 
Select the FFB template to replace the FFB in the configuration. 
 
Mark the option Only Logic at the top of the Replace FFB dialog box to replace only the internal 
algorithm (logic) of the FFB. 
 
Click Ok to conclude. 
 
 

Trends 
 
A Trend is a parameter configured to transmit, at customized intervals, its value to a server, which 
consolidates the information providing historic reports from the parameter behavior. Only input or 
output parameters from Function Blocks and Flexible Function Blocks can be configured as Trends. 
 

ATTENTION 

The configuration related to trends is consolidated in the TrendInfo.ini file located at the default 
path C:\Program Files\Smar\OleServers. 

Syscon generates this file when the Export Tags procedure is executed. 
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Creating a Trend 
 
The trend can only be created in the Fieldbus window. Right-click the block icon and click New 
Trend. The Trend Configuration dialog box will open. 
 

 
Figure 3.55. Trend Configuration dialog box 

 
Select the input or output parameter from the Parameter List. The Trend Type box shows the type 
of the selected input or output parameter. 
 
At the Sample Interval box, select the trend’s sampling interval in milliseconds. The minimum value 
is the value of the macrocycle from the device’s upstream Fieldbus. 
 
Select the Sample Type. The Sample Type is only available for Float trends and it determines the 
type of information that will be sampled, i.e., the parameter value or an average of the values read 
during the sampling interval. 
 
The Trends Usage box shows the information related to how many trends are supported and used 
by the device. 
 
Click Ok to conclude and the new node will be displayed in the Fieldbus window. 
 
 
Changing the Trend attributes 
 
Right-click the trend icon and select the option Attributes. The Trend Attributes dialog box will 
open. 
 

 
Figure 3.56. Trend Attributes dialog box 
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Select the Sample Interval and the Sample Type (only available for Float trends). Click Ok to 
conclude. 
 
Deleting the Trend 
 
Right-click the trend icon and select Delete Trend, or press the Delete key on the keyboard. A 
warning box will open. 
 
Click Yes to confirm the operation. 
 

ATTENTION 

When a trend is deleted it is not sent to the Recycle Bin, and therefore cannot be restored to the 
area. 
When a device is exchanged or a Flexible Function Block is replaced, Syscon checks if there are 
trends attached to the device or related to the FFB. If the parameters the trends were based on 
were deleted, the trends will also be deleted. 
If a trend is associated to a block and this block is deleted, Syscon will also delete the trend and 
send only the block to the Recycle Bin. Restoring the block from the Recycle Bin will not restore 
the trend. 

 
 

Parameters 
 
Editing Parameter Tags 
 
Parameter tags provide a symbolic reference to define inputs, outputs, and data that control the 
function block operation. Those tags are previously defined by the device’s manufacturer, but you 
can create a customized reference for the parameters configured in your strategy configuration. 
 
By default, the tags defined by the device’s manufacturer are displayed in the Process Cell, Fieldbus 
and the Strategy window. But according to the preferences set in the Parameter tab, in the 
Preferences dialog box, the tags defined by the user, or both the tags defined by the manufacturer 
and the user, can be displayed in the Process Cell, Fieldbus and the Strategy window. See section 
Preferences for details. 
 
Consider the following example: the block Advanced PID was added to the LD302 device. 
 

 
Figure 3.57. Example 

 
Right-click the block icon (in the Process Cell, Fieldbus or Strategy window) and click Edit User 
Parameter Tags. The User Parameter Tag dialog box will open. 
 
The following figure shows the User Parameter Tag dialog box for the Advanced PID block. 
Different blocks will have different parameter tags available for edition. 
 



SYSCON 6.5 - User’s Manual 
 

3.38 

 
Figure 3.58. User Parameter Tag dialog box 

 
Right-click the parameter icon on the User Tag column and click Edit. Type the custom tag and 
press Enter on your keyboard. Do not use blank spaces! See the example below: 
 

 
Figure 3.59. Custom Parameter Tags 

 
After editing the parameter tags, click Ok to close the User Parameter Tag dialog box. 
 
According to the Parameter Preferences set by the user, the Fieldbus window will show the 
parameter tags defined by the user, and the example above will look like the following figure: 
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Figure 3.60. Parameter tags defined by the user 

 
If the option Both - FF Name (User Tag) is selected in the Parameter Preferences dialog box, the 
tags of the parameters defined by the device manufacturer will be followed by the tags defined by 
the user in parentheses, as in the following figure: 
 

 
Figure 3.61. Parameter tags defined by the user 

 
 
Defining Area Link Parameters 
 
For some complex configurations, it is necessary to communicate information between areas in 
different strategy configurations. This characteristic is supported by Syscon, providing an easy way 
to manage block links for complex automation projects. 
 
Area Link Parameters can be created only for block in HSE equipments. To define an area link 
parameter, right-click the block icon and select Define Area Link Parameter. 
 
Select the desired parameter and click Ok to conclude. See the example below: 
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Figure 3.62. Defining Area Link Parameters 

 
Only parameters not yet linked are available to be defined as an Area Link Parameter. Once 
defined, they can only be linked through the Area Link Tool. If you need to publish an output 
parameter to its original Area and also to another Area, you have the following options: 
 

• Create a Transfer Block and link your output to one input of the Transfer Block. Mark the 
Transfer Block output as Area Link Parameter. Use your output block parameter to create 
links with Syscon and the Transfer Block output to create links using the Area Link Tool; 

 
• If you are using FFBs, create one new input and one new output points and connect them 

using Ladder Logic. Mark the new FFB output parameter as an Area Link Parameter and 
link your output to the new FFB input point. Use your output block parameter to create links 
with Syscon and the FFB output to create links through the Area Link Tool. 

 
If you have already created a default parameter for the block, it is also possible to redefine that 
parameter as an area link parameter. Right-click the desired parameter and select Enable Area 
Link. 
 
To disable an area link parameter, right-click the parameter and select Disable Area Link. Or to 
remove the area link parameter from the configuration, right-click the parameter and select Delete 
Parameter. 
 
 
Customizing the Parameters List 
 
You can customize the list of parameters displayed in the Characterization dialog box. 
 
Right-click the block icon and click Customize Characterization. The Customization dialog box 
will open. 
 

 
Figure 3.63. Customization Dialog Box 

 
At the Default tab, select the parameters that are shown for the block from the same type as the 

one selected, when you click the Customization by Type (Default) button  on the 
Characterization toolbar. This customization will affect all strategy configurations. 
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At the Type tab, select the parameters that are shown for the block from the same type as the one 
selected, when you right-click the bottom of the Characterization dialog box and mark the option 
Type. This customization will affect just the current configuration. 
 
At the Tag tab, select the parameters that are shown just for the block selected, when you right-click 
the bottom of the Characterization dialog box and mark the option Tag. This customization will 
affect just the current configuration. 
 
To include a parameter on the list, select the parameter on the Available Parameters box and click 

. 
 
To exclude a parameter from the list, select the parameter on the Selected Parameters box and 
click . 
 
Click Ok to apply all changes made to the list of selected parameter and close the Customization 
dialog box. 
 

ATTENTION 

The Apply button does not close the Customization dialog box but applies all changes made to 
the list of selected parameter, therefore clicking Cancel to discard the alterations on the 
Customization dialog box after clicking Apply will not undo the alterations since they have 
already been accepted. 

 
 
Ordering Parameters 
 
Block parameters can be ordered on the Process Cell or the Fieldbus window. 
 
Select the parameter icon and drag it over the other parameter icon. The selected parameter will be 
placed above the other one on the list. 
 
The changes made to the parameter list on the Process Cell window will be reflected on the 
Fieldbus window, and vice-versa. 
 
 
Deleting Parameters 
 
To remove a block parameter, right-click the parameter icon and click Delete Parameter, or press 
the Delete key on the keyboard. 
 
The warning dialog box will open. Click Yes to confirm the operation. 
 

ATTENTION 

Parameters from Profibus and DeviceNet devices can not be deleted. 
 
 

Strategies 
 
Creating Strategies 
 
There is a Strategy window for every control module. Right-click the control module icon and click 
Strategy, or double-click the control module icon. 
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Figure 3.64. Strategy Window 

 
Use the same procedure to open an existing Strategy. 
 
 
Saving Strategies 
 

Click on the Strategy window in case the focus is on another window and click Save  on the 
main toolbar. Anytime the drawing is changed, do not forget to save it. 
 
 
Importing a Template into the Strategy window 
 

Open the Strategy window and click Import Strategy Template  on the Strategy toolbar. The 
Open dialog box will open. 
 
In the Look in box, select the folder that contains the desired template file. Double-click the 
template file icon to import the strategy. 
 
The template drawing will be added to the Strategy window. Click Ok to confirm the import 
procedure. 
 
The Tag Table dialog box will show the list with the new block tags, based on the preferences 
settings, and the old block tags, used in the template file. See the example below: 
 

 
Figure 3.65. Tag Table Dialog Box 

 
To edit a tag, right-click the block icon at the New Tag column and click Rename. Type the new tag 
and click Enter on the keyboard. Click Ok to close the Tag Table dialog box. 
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The blocks, links and parameters will be attached to the corresponding control module. 
 

NOTE 

From Syscon version 5.20 on, the block created or imported from a template file in the Strategy 
window is automatically attached to the corresponding control module. 
If you are opening a configuration file from a previous version of Syscon and this file contains 
block templates in the Strategy, these blocks will appear in the Strategy window but will not be 
attached to the control module. Right-click the block in the Strategy window and select the option 
Attach to Model. 

 
 
Exporting a Template from the Strategy window 
 
Open the Strategy window and select the blocks and links that will be included in the template file, 
using the Select tool . 
 

Click Export Selected Strategy as Template  on the Strategy toolbar. The Save As dialog box 
will open. In the Save in box, select the folder where the template file will be saved. It is 
recommended to save templates files in the default folder, in the Syscon installation directory. The 
default path is C:\Program Files\Smar\Syscon\Templates. 
 
Type the name for the template in the File Name box and click Save to conclude. The selected 
Strategy will be saved in a file and it can be used in another strategy configuration. 
 
 
Adding Blocks to the Strategy 
 

On the Strategy toolbar, click the button Function Block . Then, click the drawing area and the 
New Block dialog box will open. 
 
Select the Block Manufacturer from the list and the Device Type provided by the selected 
manufacturer. Select the Block Type and type a related tag for the block. If a new tag is not typed, 
the tag will be generated according to the Preferences Settings of the current configuration. 
 

 
Figure 3.66. Adding a Block in the Strategy Window 

 
Click Ok to conclude. 
 
After adding at least one block, use the popup menu to add other blocks from the same 

manufacturer and from the same device type. Click the button Function Block  and right-click 
the drawing area. Select the type of the block from the list and the new block will be drawn on the 
Strategy window. 
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Figure 3.67. New Block in the Strategy Window 

 
 
Dragging Blocks to the Strategy window 
 
Select the block icon on the Process Cell or Fieldbus window and hold the mouse button down while 
dragging the block to the drawing area of the Strategy window. If the block is dropped too close to 
another block already added to the Strategy window, the block will not be drawn. 
 
You can create more than one graphical representation of the block in the Strategy window by 
dragging the block icon, but only one block is attached to the control module. 
 
Remember that you can display the windows side by side to organize the windows and make them 
easy to be used: go to the Window menu and click Tile, and it will organize the windows opened 
inside the application. 
 
 
Removing Blocks from the Strategy 
 
Be very careful when removing a block from the Strategy window! You can remove the block only 
from the Strategy window or from the area. 
 

Click Select  on the Strategy toolbar and select the block to be removed from the Strategy 
window. Right-click the block and click Delete from the menu or press Delete on the keyboard. 
 
The Function Block Deletion dialog box will open. If more than one block is selected, this dialog 
box will open to confirm the deletion of each block. Observe the following figure: 
 

 
Figure 3.68. Function Block Deletion 

 
Click Yes to remove the block from the area. Attention! Clicking this button will remove the block 
from the Strategy window, from the control module and from the device. You will lose the block 
parameters and links. 
 
Click No to remove the block only from the Strategy window. Later on, you can drag the block again 
and restore the links. See section Restoring Links. If the block is not to be deleted, click Cancel. 
 
To delete all objects from the Strategy window, press Ctrl+Del on the keyboard. 
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Selecting Objects at the Strategy Window 
 

• To select a single object, click Select  on the Strategy toolbar and click the object. 
 

• To select two or more objects, click Select  on the Strategy toolbar, click the drawing 
area and hold the mouse button down while dragging a rubber band around the objects. Or 
click each object on the Strategy window while holding down the Shift key on the keyboard. 

 
• To select all objects, press Ctrl+A on your keyboard. 

 
 
Changing Blocks Appearance 
 
Changing the Block Tag 

Click the button Strategy Modify  on the Strategy toolbar and click the block label. Type the 
new tag and click the drawing area to exit the edit mode. 
 
The new tag will automatically change in the Process Cell window. 
 
 
Changing Block Dimension Attributes 
Click Select  on the Strategy toolbar. Right-click the block on the drawing area and click the 
option Same Width and Height from the menu. 
 

 
Figure 3.69. Changing Block Dimension 

 
 
Showing Block Types 
Click Select  on the Strategy toolbar. Right-click the block on the drawing area and click the 
option Show Info from the menu. 
 

 
Figure 3.70. Showing Block Type 

 
 
Changing Block Properties 
Click Select  on the Strategy toolbar. Right-click the block on the drawing area and click the 
option Properties. The Object Properties dialog box will open. 
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Figure 3.71. Object Properties Dialog Box 

 
You can change different properties at each tab. See section Object Properties for details. 
 
Click Ok to close the dialog box and return to the Strategy window. 
 
 
Changing the Block Default Format 
The default format for blocks is the ellipse. To change the default format, go to the Option menu, 
select Function Block Icon and click one of the available formats: rectangle, rounded rectangle 
or ellipse. 
 
The next figure shows the different block formats: 
 

 
Figure 3.72. Block Formats 

 
You can also define the block default format on the Strategy Preferences dialog box. See section 
Strategy Preferences. 
 
 

Block Links 
 
Graphical Representation for Links 
 
Links between blocks can be graphically represented in different formats, according to the physical 
localization of the field devices which contain the blocks connected in the strategy window. 
 

• H1 or HSE Internal Link: this link is represented by a solid line and indicates the connection 
between function blocks from a single field device, or from a single controller. 

The example below shows the graphical representation of an internal link between the blocks 
TT302_AI and TT302-PID-1 from the device TT302. 
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Figure 3.73. Example of Internal Link 

 
 

• H1 External Link or H1 Bridge Link: this link is represented by a dash-dot line and 
indicates the connection between function blocks from different field devices which are 
connected through the same bridge, in the same H1 channel, or in different H1 channels. 

The example below shows the graphical representation of an external link between the block 
P201-AI from the device P201 and the block TT302-PID-1 from the device TT302. The field 
devices are connected through the bridge DF62_153 in the same fieldbus channel. 

 
Figure 3.74. Example of H1 External Link 

 
 

• HSE External Link or HSE Bridge Link: this link is represented by a dashed line and 
indicates that the blocks are linked through two or more networks, such as H1-H1, or H1-
HSE, or H1-HSE-H1. 

The example below shows the graphical representation of a link between blocks using 
bridges. The block TT302_AI from the device TT302 is attached to the bridge DF62_153. 
This block is linked to the TIC102_PID from the device FI302 attached to the DF62_146. 



SYSCON 6.5 - User’s Manual 
 

3.48 

 
Figure 3.75. Example of HSE External Link 

 
 

• Unrealized Link: a link is called unrealized when one of the function blocks is not attached 
to any device in the configuration or when the function blocks are attached to devices that 
are included in the configuration but there is no physical network between the devices to 
enable the communication between the blocks. This link is represented by a dotted line. 

See the example below. There is no physical network to enable the communication between 
the block LD302_01-AI-1 from the device LD302_01 and the block TT302_01-EPID-1 from 
the device TT302_01. 

 
Figure 3.76. Example of Unrealized Link 

 
Creating a Link 
 
Blocks can only be linked inside the Strategy window. 
 

Click the button Link  on the Strategy toolbar and click the block. 
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Figure 3.77. Linking Blocks - Output Parameter 

 
The Output Parameter Selection dialog box will open: 
 

 
Figure 3.78. Output Parameter Selection Dialog Box 

 
Place the cursor over the OUT Parameter and a short explanation will be displayed at the 
Parameter Description text box. Click the OUT Parameter to select it and click Ok. 
 
Return to the Strategy window and click the target block for the link. 
 

 
Figure 3.79. Linking Blocks - Input Parameter 

 
The Input Parameter Selection dialog box will open: 
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Figure 3.80. Input Parameter Selection Dialog Box 

 
Select the Input Parameter and click Ok. The link will be automatically drawn: 
 

 
Figure 3.81. Linked Blocks 

 
 
Fast Link Process 
 

Click the button Link  on the Strategy toolbar. 
 
Right-click the block and select the Output Parameter from the list. Then right-click the target block 
and select the Input Parameter from the list. 
 
See the following example of linked block into a Cascade Control design: 
 

 
Figure 3.82. Cascade Control Example 

 
 
Link Attributes 
 

Use the button Select  on the Strategy toolbar to select a link or right-click the link to activate the 
menu. 
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On the Labels submenu: 
 

• Show Link Label: shows the link label if the option is checked. 

• Show Output Parameter: shows the Link Output Parameter label if the option is checked. 

• Show Input Parameter: shows the Link Input Parameter label if the option is checked. 
 

 
Figure 3.83. Labels Menu 

 
On the Reference Point submenu, select the reference point for the Modifying tool: 
 

• Ref. On Current Point: the selected handle is the reference itself. 

• Ref. On Previous Point: the selected handle will be placed based on the position of the 
previous handle. 

• Ref. On Next Point: the selected handle will be placed based on the position of the next 
handle. 

 

 
Figure 3.84. Reference Point Menu 

 
Click the option Properties to open the Object Properties dialog box and change the line and fill 
colors, for example. See section Object Properties. 
 
 
Removing Links 
 

Click Select  on the Strategy toolbar. Right-click the link and click Delete. Or select the link and 
press Delete on the keyboard. 
 
A message box will open. Click Yes to remove the link from the area. Click No to remove the link 
only from the Strategy window. In this case, the link can be restored later. See section Restoring 
Links. 
 
 
Restoring Links 
 
Links that are removed from the Strategy window only can be graphically restored later on. 
 
Right-click the block that had a link deleted at the Strategy window and click Show Hidden Links. 
 
The links once removed from the Strategy window will be restored. 
 
 
Redrawing Links 
 
A link line can be redrawn dragging the modifying handles in the drawing area, creating a new 
handle or removing a handle. 
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Consider the following strategy: 
 

 
Figure 3.85. Another Example of Control Strategy 

 

Click Select  on the Strategy toolbar. Select the link line and click Modify  on the Strategy 
toolbar. 
 
Click the link line to create a new modifying handle. See the example: 
 

 
Figure 3.86. Modify Handle Tool 

 
Click the handle and drag it over the drawing area to redraw the link. 
 
According to the reference point, hold the Ctrl key while dragging the handle to draw a horizontal or 
vertical line from the reference handle. Or hold the Shift key while dragging the handle to draw a 
diagonal line from the reference handle. 
 
See in the following figure the new link: 
 

 
Figure 3.87. Redrawn Links 

 
Click the link line to create a new handle and right-click a handle to remove the modifying handle. 
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Reconnecting blocks 
 
A link between blocks can be reconnected by selecting another input or output parameter from a 
block other than the blocks from the original link. Use this procedure instead of deleting existing 
links and creating another link for the blocks that should be connected. 
 

On the strategy window, click the button  on the strategy toolbar to select the Strategy Modify 
tool. 
 
Click the end of the link line and hold the mouse button down while dragging the line to the desired 
block. A dialog box will show the input or output parameters available for the block. Select the 
parameter to reconnect the block and click Ok. 
 
The new link will be displayed on the strategy window and the information will also be updated on 
the process cell and fieldbus window. 
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Section 4 
 

4.1 

COMMUNICATION 
 

Introduction 
 
Once the configuration is completely ready, you can make Syscon communicate to the plant. 
 
First of all, remember that a Communication Interface must be included in the project 
configuration. If you do not have a Communication Interface in the project configuration, see 
section Creating a Controller and Creating a Bridge. 
 
 

NOTE 

Syscon can detect errors in the server to avoid a crash in the system when operating offline. 
After an error occurs in the server, Syscon does not go to Offline mode automatically nor abort 
the download operation. You must terminate the communication and restart it. Click Refresh 

 on the main toolbar to update the information displayed on the Syscon window. 
 
 

Communication Settings 
 
To configure the communication server, right-click the fieldbus networks icon and click 
Communication Settings. The Communication Settings dialog box will open: 
 

 
Figure 4.1. Communication Settings 

 
Select the Server ID. If the configuration has a HSE fieldbus, the HSE OLE Server will be selected 

when you click the On-line button . 
 
Select the server context and type the name of the server node. Click Ok to conclude. 
 
 

Initializing the Communication 
 

Click the On-line button  on the main toolbar to initialize the communication. 
 
The video clip below should appear for a few seconds. During this time, Syscon identifies and 
associates any bridge and fieldbus channels from the configuration to the real plant. 
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Figure 4.2. Initializing Communication 

 
Syscon indicates the bridges and devices included in the project configuration are not associated to 
the physical equipments, or whether a device is not communicating properly to the network. 
 
The following indications are used for devices in the Fieldbus window: 
 

 The device is operating properly. 

 The device is not connected or there is a communication failure. 

 
The device is communicating but it is not configured correctly. It is 
necessary to commission the device. 

 
To associate bridges and devices, see section Commissioning a Device below. 
 
 

Commissioning a Device 
 
The Commissioning procedure will automatically configure the equipment tag, ID and address. 
This procedure associates the bridges and devices from the project configuration file to the physical 
equipments. The option Commission is only available in the Fieldbus window. 
 
Open the Fieldbus window, right-click the equipment icon and click Commission. The Commission 
dialog box will open and display the information about the device in the configuration: 
 

 
Figure 4.3. Commissioning a device 

 

Click the button  to open the Device Selection dialog box and locate the device. 
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Figure 4.4. Device Selection 

 
When Syscon is online, the Device Selection dialog box lists the physical devices that have not 
been commissioned to the equipments in the project configuration file. For each physical device, the 
Device Selection dialog box indicates the device tag and ID, the manufacturer of the device, the 
type and the revision of the device. 
 
Select the icon of device and click Ok. When you return to the Commission dialog box, the 
information about the physical device is detailed. See the example below: 
 

 
Figure 4.5. Selecting the physical device 

 
Click Ok to conclude. 
 

NOTE 

A warning dialog box will open informing the user that it may be necessary to download the 
configuration. If there are other devices to be commissioned, click No. After commissioning all 
devices in the project configuration file, you can execute the complete download. See section 
Downloading the Configuration. 

 
Repeat this procedure for every bridge and device in every fieldbus channel, if the device has not 
been commissioned yet. Once the device’s attributes in the project configuration matches the 
attributes of the physical device, this step will not be necessary again. Syscon automatically 
associates the equipments. 
 
Open the fieldbus live list to check the plant communication and the configuration of the equipments. 
Right-click the fieldbus icon and click Live List. Each fieldbus has its own Live List. See section 
Live List. 
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Checking Commissioning 
 
Before the download, Syscon verifies commissioning to prevent fails during download caused by 
uncommissioned devices. 
 
This verification is executed for each device by comparing the values of the Device ID, the tag and 
the address defined in the configuration file to the online values read in real time from the physical 
device in the plant. 
 
If there are any differences in the attributes, the device is considered uncommissioned. A message 
box opens and indicates to the user that devices were not commissioned, as illustrate in the figure 
below. Click Yes to open a window that display the uncommissioned devices and then continue 
executing the download procedure. Click No to download the configuration without checking the 
differences among the attributes or click Cancel to abort the download. 
 

 
Figure 4.6. Checking Commissioning 

 
If you click Yes, the information related to uncommissioned devices will be displayed in the 
Checking Commissioning window. Click the icon of a device to see the details about the status of 
the device. The information is displayed on the right panel of the Checking Commissioning 
window. See the example below: 
 

 
Figure 4.7. Example of uncommissioned device 

 
If there is a device in the plant with the same tag specified in the configuration file, but the Device ID 
or the address is different, the right panel of the Checking Commissioning window will display the 
values of the Device ID or the address of the device according to the configuration file in the 
Configuration column, and the online values of the Device ID or the address of the device read 
from the physical device in the Plant column. 
 

NOTE 

Note that no procedure can be executed in the Checking Commission window. 
 
Click Ok to close this window and return to Syscon and execute the download. 
 
If you cancel the download procedure, return to Syscon, edit the device’s attributes and solve the 
problems related to commissioning. If the values of the Device ID, tag or address are different, you 
must execute the Commissioning procedure for the specific device. 
 
After correcting the differences for the devices, execute the download again. If the commissioning is 
correct, the download procedure will be completed with success. 
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Decommissioning a Device 
 
Right-click the device icon and click Decommission. 
 
Syscon will clear the device tag, the device ID and the address of the physical device in the project 
configuration. 
 

IMPORTANT 

Only for some engineering and test scenarios using Syscon in Advanced Mode, it is possible to 
delete the Device Id from the instrument without using the decommissioning procedure. See 
section Changing the Device Attributes for details. 

 
 

Error Log Registry 
 
The Error Log window reports the errors that occurred during the communication. It is important to 
clear the Error Log Registry before downloading the configuration, because any eventual error that 
might occur during the download process will be easily detected as the Error Log window pops up 
automatically at the occurrence of its first error. 
 

Click the Error Log button  on the main toolbar to open the Error Log window. 
 
Right-click the window area to activate the menu and click the option Clear Log. 
 

 
Figure 4.8. Error Log Window 

 
 

Downloading the Configuration 
 
The download procedure sends the configuration defined by the user to the devices in the plant. 
There are two download procedures: non-incremental download and incremental download. 
 
The incremental download includes a phase that compares the configuration stored in the physical 
device in the plant with the configuration in the Syscon project file, managed by the Studio302 
Database, and only the differences are downloaded. The download scope can be delimited by the 
user. 
 
On the other hand, in the non-incremental download the entire configuration stored in each device 
is deleted and the new configuration is downloaded to the devices. 
 
The download can affect a network (by selecting a Fieldbus network, a HSE network or a channel of 
the Linking Device), or the download can affect a particular device, which can be a HSE device 
(Bridge, Linking Device, I/O Gateway) or a H1 device. In this last case, the operation is also called 
partial download. 
 
The download procedure is only available when Syscon is online, communicating to the plant and 
to the devices which were already commissioned. 
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Clear the Error Log window before the download to easily detect eventual errors that might occur. 
See section Error Log Registry above. 
 
When selecting the option to execute the download procedure, the following dialog box will open: 
 

 
Figure 4.9. Download options 

 
By default, the option Incremental Download is not selected. The other options for the download 
procedure are: 
 

• Propagate downstream: this option is available for bridges and indicates that the 
download must be executed for the H1 fieldbus channels. See details in section Bridge 
Download. 

 
• Incremental Download: when selected, this option indicates that Syscon must compare 

the project configuration to the online configuration of each device and only download the 
differences. When this option is selected, the option Advanced Options is also enabled, 
allowing the user to select which items will be compared and downloaded. See details in 
section Incremental Download. 

 
• Display differences before download: when selected, this option indicates that before 

executing the download procedure, the user must be informed about which items are 
different in the project configuration when compared to the network configuration, and then 
decide whether to execute the download or abort the procedure. 
If this option is not selected, the system will compare and apply the differences without 
warning the user about the alterations. This option is only available when the option 
Incremental Download is selected. See details in section Incremental Download. 

 
 
Incremental Download 
 
Syscon can compare the project configuration with the plant configuration and then execute the 
download only for the discrepant information, without sending unnecessary information to the 
physical device. This procedure is called Incremental Download. 
 

IMPORTANT 

If the incremental download is executed for a Profibus or DeviceNet controller, the configuration 
of the non-Fieldbus Foundation network, which was defined using the Network Configurator 
tool, will be downloaded unconditionally, that is, Syscon will not compare the non-Fieldbus 
Foundation network configuration. 
If the download is executed for an AS-i controller, the non-Fieldbus Foundation network 
configuration will be compared to the on-line configuration and it will only be downloaded if there 
is discrepant information between the configurations. 

 
Blocks and links that exist in the plant configuration but not in the project configuration file are 
deleted in order to preserve the project configuration consistency. New block and links (and new 
values for the parameters if the user selects the option Download parameters) are downloaded to 
the plant. 
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In the Download dialog box, select the option Incremental download and the option Display 
differences before download will be enabled. If this option is marked, first Syscon compares the 
project configuration and the configuration in the physical devices without downloading any 
information. After the comparison, Syscon indicates in another window which items related to the 
devices (such as blocks and links) in the project configuration are different from the items read from 
the physical devices. 
 

 
Figure 4.10. Incremental Download window 

 
The panel on the left shows the topology tree. The panel on the right describes the discrepancies for 
the item selected on the left panel. 
 
The Incremental Download window has its own toolbar. The following table describes the 
functionalities of the buttons: 
 

 Click this button to refresh the information on the window. 

 Click this button to expand all nodes. 

 Click this button to collapse all nodes. 

 Execute the download and close the Incremental Download window. 

 Cancel the download and close the Incremental Download window. 

 Click this button to open the Syscon Online Help. 

 
The Incremental Download window has four filter levels that classify all of the blocks and 
parameters attributes for the device: 
 

 
Indicates that there are no discrepancies in the configurations and the download 
is not necessary for the selected device. 

 

The Low Severity filter indicates that there are discrepancies in the configurations 
but there is no impact and the download is not necessary for the selected device. 
For example, a misused resource is detected. See section Misused Resource 
Indication below. 

 
The High Severity filter indicates that there are discrepancies in the configurations 
and it is necessary to download the selected device. 

 This filter will display all attributes. 
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Click the column headers (Description, Configuration or Plant) on the right panel to sort the list of 
information. Clicking the column header will toggle between ascendant or descendent sorting. 
 
After analyzing which items are affected, you can continue and execute the download procedure 
clicking Ok, or abort the operation clicking Cancel. 
 

Misused Resource Indication 
In the Incremental Download procedure, when the phase of comparing configurations is concluded, 
the window with the differences opens and indicates whether the items in the Syscon project 
configuration have discrepancies or not considering the devices connected to the network. 
 
When several download procedures are executed in a period of time, a H1 device, bridge or 
controller may indicated a Misused Resource in the Incremental Download window. 
 

 
Figure 4.11. Misused resource indication 

 
This indication appears every time Syscon detects that there is a resource allocated in the device 
that is no longer needed and therefore can be deleted during the incremental download. 
 
The severity level for this indication is low, which means that if a misused resource is the only 
discrepancy reported in the comparison phase, the download will not be necessary since the device 
is operating properly. 
 

Incremental Download Advanced Options 
When the user selects the option Incremental Download, the Advanced Options button is 
enabled to define the procedure scope. 
 

 
Figure 4.12. Download Advanced Options 
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• Blocks: Mark this option to compare the blocks from the strategy configuration to the 
blocks from the plant. Blocks are created and deleted according to the differences found. If 
this option is not marked, blocks will be ignored and, even if there are differences between 
the configuration and the plant, the blocks will not be created or deleted. 

 
• Parameters: Mark this option to compare the parameters from each block in the offline 

configuration to the parameters read from the devices in online mode. If the values differ, 
they will be downloaded. If this option is not marked, parameters will be ignored, that is, the 
parameters are not compared or downloaded. 

 
• Links: Mark this option to compare the links between function blocks block in the strategy 

configuration to the links from the plant. Links are created and deleted according to the 
differences found. If this option is not marked, the links will be ignored, that is, even if there 
are differences between the configuration and the plant, the links will not be created or 
deleted. 

 
• FB Schedule: Mark this option to compare the block schedule of each device involved in 

the download to the data from the plant. Values will be downloaded according to the 
differences found. If this option is not marked, the block schedule will be ignored and even 
if there are differences between the configuration and the plant, the values will be altered. 

 
• Traffic Schedule: Mark this option to download the Traffic Schedule from the H1 channel 

selected for the download. If this option is not marked, the Traffic Schedule will not be 
downloaded. 

 
• Ladder: Mark this option to download the Ladder programming from each flexible function 

block (FFB) involved in the download. This option does not depend on the option Blocks 
described above. If this option is not marked, the configurations with Ladder logic will be 
ignored and will not be downloaded. 

 
• Net IO Configuration (NetConf configuration) 

 
Profibus and DeviceNet Controllers – Mark this option to download the configuration from a 
non-Foundation network (a configuration created using Smar Network Configurator) for 
each controller involved in the download. 
 
AS-i Controllers – If this option is selected to download the AS-i network configuration 
(created using Smar Network Configurator), the network configuration will be compared 
to the plant configuration and the download will be executed if differences are detected. 
 
If this option is not marked, the non-Foundation network configuration will be ignored and 
the information will not be downloaded. 

 
• Net IO Parametrization (Mapping Tool configuration): Mark this option to compare the 

I/O mapping points information (created using Mapping Tool) for each controller, and if 
differences are detected, the configuration will be downloaded. If this option is not marked, 
the I/O mapping points information will be ignored and will not be downloaded. 

 
 
Plant Configuration Download 
 
The plant download executes the complete download procedure, which means that the information 
from every bridge, every H1 channel connected to each bridge and every device connected to each 
H1 channel will be downloaded. The option Propagate downstream is always selected. 
 
Right-click the Fieldbus Networks icon on the Project window and click Download. The Download 
dialog box will open. 
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Figure 4.13. Downloading the Plant Configuration 

 
As mentioned above, the option Propagate downstream is always enable, since the entire 
configuration should be downloaded to the plant. 
 
Select the options to execute the incremental download and click Start. See section Incremental 
Download for further details. 
 
 
Bridge Download 
 
A partial download can be executed for a bridge, that is, only the information related to the selected 
bridge will be downloaded (the option Propagate downstream is not marked), or the download 
procedure can be executed for the selected bridge, the H1 channels and the devices connected to 
these channels (the option Propagate downstream is selected). 
 
In a partial download (Propagate downstream is disabled), Syscon downloads the configuration 
of blocks, parameters and links related to the bridge, and the block schedule and traffic schedule for 
each H1 channel connected to that bridge. 
 
When the option Propagate downstream is selected, Syscon executes the download for the 
selected bridge and propagates the procedure to the H1 fieldbus channels, which means the 
download will be executed for the devices connected to all H1 channels. 
 
Right-click the bridge icon and select the option Download to open the Download dialog box. 
 

 
Figure 4.14. Downloading the Bridge 

 
Select the options to execute the incremental download and click Start to download the bridge 
information. See section Incremental Download for details. 
 
 
Ladder Logic Download 
 
The Ladder Logic download is executed for a bridge. In the non-incremental download, the logic 
programming for a FFB will be downloaded and the device information, such as the Revision and 
Manufacturer, will be updated as described in the FFB. 
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During the incremental download, if there is a flexible function block in the configuration, the logic 
programming will be downloaded and the device information will be updated as described in the 
FFB, which means Syscon does not compare FFB logics. In this case, note that the system will 
always indicate that the item in the Incremental Download dialog box must be downloaded for the 
device with FFB. 
 
In both cases, if the Live List window is opened while the device is being updated, the user will 
notice that the device exits the Live List but it is displayed again, indicating the new device 
description. 
 
 
Foundation Fieldbus Network Configuration Download 
 
When the HSE Fieldbus channel is selected, the download is executed for the bridges connected to 
this channel, and the traffic schedules are also downloaded for every H1 channel connected to the 
bridges. The H1 devices connected to the H1 channels of the bridges are not downloaded. 
 
When a H1 fieldbus channel is selected, the download is executed for all devices connected to this 
channel, except for the upstream bridge. 
 
Right-click the fieldbus icon and click Download. The Download dialog box will open. 
 

 
Figure 4.15. Downloading the Fieldbus Channel 

 
By default, the option Propagate downstream is always disabled for H1 and HSE Fieldbus 
download, since only the information related to the devices connected to a channel should be 
downloaded. 
 
Select the options to execute the incremental download and click Start. See section Incremental 
Download for details. 
 
 
Non-Foundation Fieldbus Network Configuration Download 
 
This procedure is executed for the Profibus, Devicenet and AS-i controllers. 
 
In the non-incremental download, the non-Foundation Fieldbus network configuration (created 
using Smar Network Configurator) is downloaded. 
 
In the incremental download related to the Profibus or DeviceNet controller, the non-Foundation 
network configuration (created using Smar Network Configurator) is downloaded unconditionally, 
that is, Syscon will not compare the network configuration. In the incremental download related to 
the AS-i controller, the non-Foundation network configuration will be compared to the plant 
configuration and the download will be executed if differences are detected. 
 
 
H1 Device Download 
 
To execute the download for the device, double-click the icon of the fieldbus channel where the 
device is connected to open the corresponding Fieldbus window. Right-click the device icon and 
click Update. See the example below: 
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Figure 4.16. Updating the device information 

 
The replaced device tag will exit the Live List and the new device tag will appear. Now you can run 
the partial download. 
 
The procedure for a H1 device downloads blocks, parameters, flexible function blocks, links, and 
function block schedule related to the device, and also downloads the traffic schedule of the H1 
channel where the device is connected. 
 
During the incremental download, Syscon verifies if every block in the offline configuration has 
been instantiated correctly. If the block does not exist in the configuration, or if it exists but the block 
type is different (Profile and Profile Revision are different), Syscon will instantiate the block 
according to the offline configuration. Links are then compared and those that have not been 
instantiated yet are created. Links that only exist in the plant are deleted. 
 
By default, the option to download parameters is not selected in the incremental download. 
Configure the download advanced options to download parameters (See section Advanced 
Options in the Incremental Download section). 
 
The Function Block Schedule is a data structure, calculated by the configurator and stored for each 
device in order to inform which blocks must be executed in the device. This structure is usually 
altered (and automatically calculated by the system) every time a block is added to the device or 
removed from the device. In the non-incremental download, the Function Block Schedule is always 
downloaded. During the incremental download, if a H1 device is selected, the Function Block 
Schedule from the offline configuration is compared to the plant device and the information will be 
downloaded if there are any differences. If a HSE device is selected, the Function Block Schedule 
will always be downloaded. 
 
To execute the device download, open the Fieldbus window corresponding to the channel where the 
device is connected, right-click the device icon and click Download. The Download dialog box will 
open. 
 
Select the options to execute the incremental download and click Start. See section Incremental 
Download for details. 
 

ATTENTION 

The device download automatically downloads the traffic schedule of the upstream channel of 
the device. 

 
 
H1 Fieldbus Channel Traffic Schedule Download 
 
The Traffic Schedule is a data structure, calculated by the configurator and stored for each Link 
Master connected to a H1 Fieldbus channel in order to inform which devices access the network 
and in which order they access the network, in order to publish the output parameters for the links. 
This structure is usually altered (and automatically calculated by the system) every time a link that 
requires publishing is added to the device or removed from the device. 
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The Traffic Schedule can be defined in the Fieldbus Attributes dialog box. See section Changing 
the Fieldbus attributes for details. 
 
Right-click the fieldbus icon and click Download Schedule. A message box will open to confirm the 
operation. 
 

 
Figure 4.17. Confirming the Schedule Download 

 
Click Yes to download the schedule. 
 
The Traffic Schedule is downloaded unconditionally. Note that the system will always indicate in the 
Incremental Download dialog box that there are differences between channels and the download 
must be executed. 
 

NOTE 

The option Download Schedule is not available for HSE fielbuses. 
 
 

When Should I Save the Configuration Before Executing the Download? 
 
You must save the configuration before executing the download every time: 
 

• The configuration from the Network Configurator has been altered; 
• An I/O Point has been added or altered using the Mapping Tool. 

 
Executing the download without saving the Syscon strategy configuration may result in 
mismatching addresses of I/O Points, causing the instruments to operate with inappropriate points, 
that is, when writing to an input, the output may be in a point other than specified in the 
configuration. Address mismatch can cause the plant to behave unexpectedly. 
 
If you are not working with any controller (AS-i, Modbus, DeviceNet, etc.) or have not made any 
configuration changes using the Network Configurator or the Mapping Tool, it will not be 
necessary to save the Syscon strategy configuration. 
 
 

Usual Cases for the Download Procedure 
 
Plant Download – Non-Incremental 
 
The first configuration download must always be the complete download for the plant, because the 
entire project configuration should be downloaded to the physical devices. The option Incremental 
Download should not be selected since there is no comparison to be made to the configurations. 
 
Incremental Download (Plant, HSE and H1 channels, Devices) 
 
If the project configuration changes and the download should not cause a big impact in the plant 
communication, the incremental download should be executed. Analyze the alterations made to the 
project configuration and select the appropriate level for download. 
 
If only one device configuration was altered, the incremental download should be executed in that 
device; however, if several bridges and devices were altered, the incremental download should be 
executed for the Fieldbus Networks. 
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Every time the Define Parameters procedure is executed for a FFB, the existing parameters may 
have their related Relative Index altered. Since every device with FFB links uses this information, it 
is necessary to check every device with links to the altered block in order to repair links, when 
needed. 
 
Therefore, after altering a FFB using the Define Parameters procedure, it is recommended to run 
the Plant Incremental Download. 
 
Bridge, Controller or Device Partial Download 
 
Whether a failure occurred in the device or the device was replaced, or a new device was 
commissioned, it is necessary to download the device only if the plant configuration (other 
devices, for example) has not been affected. 
 
Alterations made to one device can affect other equipments. For example, an alteration in an 
external link will affect at least two devices and the LAS. Therefore, if the project configuration was 
altered, all device affected by this alteration must be downloaded; otherwise a partial download may 
generate unexpected results. In this case, it is recommended to execute a plant download. 
 
 

Download Failures 
 
If the Syscon download procedure reports a download failure for any equipment, follow the steps 
below to correct the failures: 
 

• Wait until the download procedure is concluded, when the Download dialog box 
automatically closes; 

• For each equipment that indicated a download failure, right-click its icon and select the 
option Update; 

• Then, execute the download for the equipments that were updated. See section Device 
Download for details. 

 
 

Uploading the Configuration 
 
This procedure uploads the configuration from the physical bridges and devices to the project file. It 

is necessary to initialize the communication to execute the upload. Click the On-line button  on 
the toolbar. 
 
Right-click the Fieldbus Networks icon on the Project window and click Upload. The Upload dialog 
box will open. 
 

 
Figure 4.18. Upload Dialog Box 
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Mark all the Filters to upload the entire plant configuration: Topology, Device List, Block List and 
Parameters. Click Start. The progress bars indicate that Syscon is reading the information from the 
fieldbuses and adding the devices, blocks and parameters to the configuration file. 
 
You can stop this process at any time during the upload by clicking Abort in the Upload dialog box. 
 

IMPORTANT 

If during the Upload procedure Linking Devices with no FBAP were detected, which means there 
are only CFH files in the Device Support folder, those devices will be created in the 
configuration as “Dummy” bridges. At the end of the Upload procedure, it will be necessary to 
import DD files to the Device Support, or exchange the bridge, replacing a “Dummy” bridge for 
a controller with CFH and DD files configured in the Device Support folder. 

See section Importing Files for Linking Devices with no FBAP for details on how to import 
the missing files, and section Device Exchange on how to execute the Exchange procedure for 
bridges. 

 
 
Partial Upload 
 
You can run a partial upload for fieldbuses, devices or blocks according to the filters selected on the 
Upload dialog box. 
 

Remember it is necessary to click the button  to initialize the communication and execute the 
upload. 
 

Topology Upload 
Syscon uploads the bridges and the connected fieldbus channels. 
 
Right-click the Fieldbus Networks icon on the Project window and click Upload. On the Upload 
dialog box, select only the filter Topology and click Start. 
 

Device Upload 
Syscon uploads the devices for the selected Fieldbus channel. 
 
Right-click the Fieldbus icon on the Fieldbus window and click Upload. On the Upload dialog box, 
the filter Topology is already selected. Select the filter Device List and click Start. 
 

Block Upload 
Syscon uploads the blocks for the selected device. 
 
Right-click the device icon on the Fieldbus window and click Upload. On the Upload dialog box, the 
filters Topology and Device List are already selected. Select only the filter Block List and click 
Start. 
 

Parameter Upload 
Syscon uploads the parameters for the selected block. 
 
Right-click the block icon on the Fieldbus window and click Upload. On the Upload dialog box, 
select the filter Parameters and click Start. 
 
 

Live List 
 
Use the Live List to check the devices communicating on the channel. Each fieldbus has its own 
Live List. Right-click a fieldbus icon and click Live List. The Live List window will open. 
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Figure 4.19. Live List Window 

 
The Live List indicates the devices and bridges, identified by the Device Tag, Device ID and Device 
Address, as well as the device configured as the Active LAS. The Active LAS will be indicated with a 
different icon in the Live List. The following table describes the icons that identify devices and 
bridges on the Live List window: 
 

 Active LAS Bridge. 

 
Bridge configured to assume the LAS function when the Active LAS stops 
communicating. 

 Active LAS Device. 

 
Device configured to assume the LAS function when the Active LAS stops 
communicating. 

 H1 or HSE Bridge. 

 H1 or HSE Device. 

 Device information reading in progress. 

 HSE Host. 

 Profibus, DeviceNet or AS-i Controller. 

 Profibus, DeviceNet or AS-i Device. 

 Controller or I/O Module. 

 
Bridge or device missing support files (DD, CF or FFB files). This scenario occurs 
when a FFB with ladder logic is added to the configuration. 

 
 
Live List Menu Options 
 
Right-click the device icon on the Live List window and select one of the options described below. 
 

Assign Tag 
The Assign Tag dialog box will open. Define a new tag for the device and click Ok. 
 

 
Figure 4.20. Assign Tag Dialog Box 
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Attributes 
The Device Attributes dialog box will open. This dialog box displays the attributes for the selected 
device, such as its manufacturer, revision and ID. 
 
It is not possible to edit the device attributes in this dialog box. 
 

 
Figure 4.21. Device Attributes Dialog Box 

 

Upload 
Click this option to upload the selected device to the corresponding Fieldbus channel. The following 
dialog box will open while the device is being uploaded. 
 

 
Figure 4.22. Uploading the Device 

 
 

Block List 
 
Use the Block List to check the blocks that are instantiated in the device. Each device has its own 
Block List. On the Fieldbus window, click the expansion sign of the device and right-click the VFD 
icon. Click the option Block List from the menu. 
 
The Block List window will open. 
 

 
Figure 4.23. Block List Window 
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Block List Menu Options 
 
Right-click the block icon on the Block List window and select one of the options described below. 
 

Assign Tag 
The Assign Tag dialog box will open. Type the new tag and click Ok. 
 

 
Figure 4.24. Assign Tag Dialog Box 

 

Attributes 
The Block Info dialog box will open. This dialog box displays the attributes for the selected block, 
such as the Device Revision and block type. 
 
It is not possible to edit the block attributes in this dialog box. 
 

 
Figure 4.25. Block Info Dialog Box 

 

Characterization 
The On Line Characterization dialog box will open. See section Block On Line Characterization 
for details. 
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Figure 4.26. Characterization Window 

 

Upload Block 
Click this option to upload the selected block to the corresponding device. 
 
 

Exporting Tags 
 
Export Tags 
 
The Taginfo.ini file contains all tags from devices, function blocks and logics tags created in the 
configuration file, enabling the on-line communication for browsing and supervision. Every time any 
tag is changed in the configuration, it is necessary to repeat the Export Tag procedure, otherwise 
the supervision of the new tag will not be allowed. 
 
It is recommended to execute the Export Tag procedure before any download operation. 
 
To execute this procedure, right-click the area icon and click Export Tags. Select the folder to save 
the Taginfo.ini file and click Save. The default path for the Taginfo.ini file is C:\Program 
Files\Smar\OleServers\. 
 
You can set the option to automatically export the tags, in the Preferences dialog box, every time a 
relevant online procedure requires a tag to be exported. In this case, a message box will ask you to 
confirm the Export Tag procedure. See section Block Preferences. 
 

NOTES 

1. If there are two or more configuration files, i.e., two or more Areas, the tag lists from these 
sources must be consolidated in a single list, so the OPC Server can use the entire list 
of tags to provide the information requested by any OPC client application. 

2. You must assure that the tags used in all the configuration files are unique. If there are 
duplicated tags, only one tag will be exported to the Taginfo.ini file. 

3. When you export the tags of a configuration that has already been consolidated, only the 
tags of the configuration that is currently open are updated in the consolidated list. The 
tags of the other configurations are not affected. 

 
IMPORTANT 

The Export Tags procedure also automatically creates the file TrendInfo.ini, which consolidates 
the configuration of trends created in the Syscon strategy configuration, and the file 
AlarmInfo.ini, which provides the information related to alarm and events configured in Syscon 
to the Smar A&E Server. Refer to sections Trends and Preferences for further details about 
these files. 
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Export Tags for OPC Browsing 
 
The Export Tags For OPC Browsing procedure updates the Taginfo.ini file with all tags from all 
logics used in this configuration (i.e., Areas), enabling them for browsing without downloading the 
configuration to the controller. 
 
Use this procedure if you have already downloaded a configuration that contains a Logic and now 
you want to change the Logic in some way, but you cannot immediately download it to the controller. 
At the same time, you want to get the tags from the Logic to use them to build a new supervisory 
window (i.e., you want to browse them). 
 
 

NOTES 

1. Do not mix this operation with Export Tags: after downloading the configuration to the 
controller, the Export Tags procedure must be executed instead. 

2. Although the Export Tags for OPC Browsing operation also updates the Taginfo.ini file 
with all tags from the logic configuration, it only enables the tags for browsing. 

3. During the Flexible Function Block download, FFB tags are automatically exported for 
browsing and supervision usage. 

 
 

Exporting the Configuration 
 
You can export the strategy configuration to a XML file. Then, import the XML file to a MS Excel 
worksheet or a MS Access database. Right-click the project icon and click Export Configuration. 
The Browse for Folder dialog box will open. 
 

 
Figure 4.27. Browse for Folder Dialog Box 

 
Select the folder where the file will be saved and click Ok. A message box will indicate the strategy 
configuration was exported successfully. Click Ok to conclude. The directory XmlExport is created 
on the selected folder, containing a subdirectory named after the strategy configuration. 
 
The XML file names have the following format: “<Area name>_<data type>.xml”. For example, the 
XML file name that contains information about control modules from the strategy configuration name 
Proj01 will be “Proj01_ControlModule.xml”. 
 
In order to import data from the XML file to a MS Excel worksheet, open the MS Excel file, go to the 
Data menu and click XML > Import. Select the XML file icon and click Import. Data related to the 
strategy configuration will be arranged on the worksheet columns. 
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Consolidating the OPC Database 
 
When working with two or more configuration files, the tag lists from these source files must be 
consolidated in a single list. 
 
On the Project window, right-click the project icon and click Consolidate OPC Database. The 
Consolidate OPC Database dialog box will open. 
 

 
Figure 4.28. Consolidate OPC Database dialog box 

 
 
Adding a Configuration 
 
To add the current configuration to the consolidate list, click Add This on the Consolidate OPC 
Database dialog box. A message box will open to confirm the operation. 
 

 
Figure 4.29. Adding a Configuration 

 
Click Yes to include the tag list of the current configuration to the tag list of the OPC Server. The 
name of the configuration will be added to the list of configurations. 
 
To add another configuration to the list, it is necessary to open the configuration in Syscon 
application and repeat this procedure. 
 
 
Removing a Configuration 
 
To remove a configuration from the consolidate list, select the name of the configuration in the 
Configurations list and click Remove.  
 
A message box will open to confirm the operation. Click Yes to remove the selected configuration 
from the tag list of the OPC Server. The name of the configuration will be removed from the list of 
configurations. 
 
 
Updating a Configuration 
 
If the tag list of a consolidated configuration changes, it will be necessary to update the tag list of the 
OPC Server. 
 
Open the configuration file that had the tag list updated. Right-click the project icon and click 
Consolidate OPC Database. On the Consolidate OPC Database dialog box, click Update This. 
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Figure 4.30. Updating the tag list 

 
A message box will open to confirm the operation. Click Yes to update the tag list in the OPC 
Server. 
 

IMPORTANT 

This procedure has the same functionality of the Export Tags and Update OPC Database 
options, in the Export menu. 

 
 
Clearing the Consolidated List 
 
To reset the list of consolidated configurations and remove all of the tag lists from the OPC Server, 
open any configuration file in Syscon, right-click the project icon and click Consolidate OPC 
Database to open the dialog box. 
 
The list of configurations that have been consolidated will be displayed. Click the button Clear All. A 
message box will open to confirm the operation. 
 
Click Yes to reset the consolidated tag list of the OPC Server. 
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Changing the Macrocycles for Specific Controllers or Bridges 
 

In some situation it may be interesting to configure different macrocycles for some specific CPUs 
(controllers or bridges). Normally the situation is related with optimization of the network traffic 
and/or need of to speed up some specific control loop. This section describes how to do that by 
using the System302 ServerManager software tool to set the Transmit Delay Time parameter and 
the Syscon software tool to set the macrocycle for a CPU (controller or bridge).  
 

IMPORTANT 

To define a specific Transmit Delay Time and Macrocycle for a CPU (controller or bridge), 
Syscon communication must be in Offline Mode (the communication server must be shut down). 

 
Defining the Transmit Delay Time parameter 
 

Click the button  on the Studio302 toolbar to run the System302 ServerManager. 
 

 
 

Figure 4.31. Starting the System302 ServerManager 
 

The System302 ServerManager dialog box will open: 
 

 
Figure 4.32. System302 ServerManager settings 
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Select the option Network. The System302 ServerManager will start: 
 

 
Figure 4.33. System302 ServerManager 

 
Select the Advanced tab, define a value for the transmit delay time parameter and cick Apply. The 
Warning dialog box will appear to inform that the new settings will only take effect on the next time 
the communication server is started. Click OK. 
 

Click the On-line button  on the main toolbar to initialize the communication. 
  

IMPORTANT 

At this point, the configuration is supposed to be totally downloaded. If that is not the case, 
download the configuration. 

 
 

Changing the macrocycle of specific CPUs 
 
Open the HSE Network window, right-click the HSE network icon and click Attributes. The 
Fieldbus dialog box will open. 
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Figure 4.34. Fieldbus Dialog Box 

 
To set the macrocycle, type the new value and click Override. 
 
Find the CPU (bridge or controller) for which you want to set the value of the macrocycle defined in 
the previous step. Right-click the bridge or controller icon and click Download. The Download 
dialog box will open. 
 
Select the options to execute the incremental download (see section Incremental Download for 
details). In the Advanced Settings (see section Incremental Download Advanced Options for 
details), leave only the FB Schedule option select, clearing any other option that might already be 
selected: 
 

 
Figure 4.35. Advanced Download Options Dialog Box 

 
Click Ok to confirm the advanced download options. Then, click Start, to start download. 
 
Repeat the steps above for every CPU (controller or bridge) you want to change the value of the 
macrocycle. 



SYSCON 6.5 - User’s Manual 
 

4.26 

After changing the macrocycle for the CPUs of interest, restore the original value of the macrocycle. 
In order to do that, open the HSE Network window, right-click the HSE network icon and click 
Attributes. The Fieldbus dialog box will open. Type the original value of the macrocycle and click 
Override. 
 

IMPORTANT 

If the configuration includes area links, it is necessary to download them again by using the Area 
Link Tool. 

 
 



Section 5 
 

5.1 

 

TEMPLATES 
 
 
It is possible to use a ready Strategy or part of it, in another file or even in another process cell. It is 
necessary to create a template file from a Strategy Configuration. After which, just import the 
template into the control module, change the tags and assign the blocks to the devices. 
 
Syscon 6.5 also creates controller, bridge and device templates, attaching blocks and configuring 
parameters. You can open the template file and the project file at the same time, and then attach the 
devices or blocks to the configuration by dragging them to the desired fieldbus channel. 
 
Using templates can speed up the strategy development work tremendously. This will make it very 
productive at the same time as the boring repetitive work is eliminated. Engineering time and costs 
are reduced. 
 
At the same time the configurations become more consistent and neater looking, and therefore 
easier to troubleshoot. Pre-configured templates also eliminate many chances of mistakes.  
 

To create a template file, click New  on the main toolbar and select the type of the desired 
template: Strategy, Device, Bridge or Controller. 
 

To open an existent template, click Open , select the template type in the Files of type box and 
double-click the template file icon to open its window in Syscon. 
 
The files *.fft are Strategy Templates; files *.dtp are Device Templates; files *.btp are Bridge 
Templates, and files *.ctp are Controller Templates. 
 
See sections Editing Strategy Templates and Editing Device, Bridge and Controller Templates 
below for further details. 
 

After editing the parameters for the template file, save the alterations clicking Save  on the main 
toolbar. On the Save As dialog box, type the name for the template and click Save. It is 
recommended to save all templates files at the default path in the Syscon installation folder: 
C:\Program Files\Smar\Syscon\Templates. 
 
 

Editing the Default Template 
 
Default template files are defined for devices, bridges and controllers. They contain pre-defined 
input, output and display transducer blocks and resources blocks, specific for each equipment. 
 
The Default Template file is located in the Device Support folder of the equipment’s manufacturer. 
The name of the template file is automatically composed by the Device Revision number (2-digits 
hexadecimal number) and the file extension: dtp for devices, btp for bridges and ctp for controllers. 
 
Syscon uses the Default Template when you are creating a controller, bridge or device and mark 
the option Creation based on Default Template at the Advanced Options tab. 
 
To edit a Default Template, click Open Default Template on the File menu. The Open Default 
Template dialog box will appear. 
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Figure 5.1. Open Default Template Dialog Box 

 
Choose the manufacturer from the list. Then, select the device type and the device revision. Click 
Ok and the Template window will open. See the example below: 
 

 
Figure 5.2. Device Template Window 

 
Double-click the block icon to open the Off Line Characterization dialog box will open. Edit the 
values for the parameters and click Close to return to the Template window. See section Block Off 
Line Characterization for details. 
 
To save the device, bridge or controller template as the Default Template, go to the File menu and 
click Save As Default Template. 
 
 

Editing Strategy Templates 
 
The Strategy Template window has the same properties as the Strategy window. You can draw 
blocks and links, and also configure block attributes. The only difference is that the blocks will not be 
attached to a control module or a device. 
 
Adding Blocks 
 

Click the button Function Block  on the Strategy toolbar and click the drawing area to open the 
New Block dialog box. 
 
Select the manufacturer from the list and the device type provided by the selected manufacturer. 
Select the Device Revision, the DD Revision and the CF Revision. 
 
Select the type of the block and type a related tag. Click Ok to conclude. 
 
After adding at least one block, use the popup menu to add other blocks from the same 

manufacturer and from the same device type. Click the button Function Block , right-click the 
drawing area and select the block type from the list. 
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Changing the Block tag 
 

Click the button Strategy Modify  on the Strategy toolbar and click the block label. Type the 
new tag for the block and click the drawing area to exit the edition mode. 
 
 
Block Off Line Characterization 
 
Click the button Select  on the Strategy toolbar and double-click the block. The Off Line 
Characterization dialog box will open. Edit the values for the parameters and click Close to exit the 
Off Line Characterization dialog box. 
 
See section Block Off Line Characterization for details. 
 
 
Creating Links 
 

Click the button Link  on the Strategy toolbar. Right-click the block and select the Output 
Parameter from the popup menu, then drag the cursor to the target block and right-click it to select 
the Input Parameter from the popup menu. 
 
See section Links for details. 
 
 

Editing Device, Bridge and Controller Templates 
 
Device, bridge or controller templates contain one device and the corresponding Resource and 
Transducer blocks. You can add or remove blocks and configure the parameters. 
 
The Device template files are those with the extension dtp, the Bridge templates are those with the 
extension btp and the Controller templates are those with the extension ctp. 
 

Click New  on the toolbar and select the template type: Device, Bridge or Controller. The 
Template window will open. 
 
Select the manufacturer from the list and the device type. Select the Device Revision, the DD 
Revision and the CF Revision, or check the option Follow the Latest DD and CF Revision to apply 
the latest revision for the selected device. When this option is selected, Syscon updates the device 
with the latest revision of the DD and CF every time the configuration file is opened. 
 
Type a related tag for the device. 
 
At the Advanced Options tab, select the options to automatically create the Resource and 
Transducers blocks. 
 
Click Ok to conclude and then save the template file. 
 
 
Changing Attributes 
 
Right-click the equipment icon and select the option Attributes. 
 
For the devices, you can type a new tag and select the BOF class. For bridges and controllers, you 
can type a new tag and enable redundancy. 
 

Click Ok to conclude and click Save  to save the alterations. 
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Creating Blocks 
 
Only the Resource and Transducers blocks can be added to the device, bridge or controller 
template. 
 
Right-click the FB VFD icon and click New Block. The New Block dialog box will open. Select the 
block type and type a related tag for the block. If you do not type a tag for the block, Syscon will 
combine the device tag with the block mnemonic to generate the new tag. 
 

Click Ok to conclude and click Save  to save the alterations. 
 
 
Changing Block Attributes 
 
Right-click the block icon and select Attributes. Only the block tag can be changed. 
 
Type the new tag for the block and click Ok to conclude. 
 

Click Save  to save the alterations to the template file. 
 
 
Block Off Line Characterization 
 
Right-click the block icon and click Off-line Characterization. The Off Line Characterization 
dialog box will open. 
 
Edit the values for the parameters and click Close to exit the Off Line Characterization dialog box. 
 
See section Block Off Line Characterization for details. 
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RECYCLE BIN 
 
Only function blocks, devices, controllers, and bridges are moved to the Recycle Bin when you 
delete one of those items from an area. Fieldbus, Profibus, DeviceNet and AS-i channels, process 
cells, control modules and Flexible Function Blocks are not sent to the Recycle Bin. 
 
The items that were sent to the Recycle Bin can be recovered at any time, even if the configuration 
is closed and opened again. 
 
To open the Recycle Bin, double-click its icon on the main window. 
 
Devices and blocks are identified by their original configuration attributes, such as tags, IDs or 

control modules. Click the button Details  on the main toolbar, to display the detailed information 
about the devices, blocks and parameters. 
 

 
Figure 6.1. Recycle Bin Window 

 
Right-click the device or block icon and select Attributes to open the Attributes dialog box. It is not 
possible to edit the attributes in this dialog box. 
 
 

Restoring Devices and Blocks 
 
To restore a bridge, device or block to the configuration, right-click the icon at the Recycle Bin and 
click Restore. 
 
The selected device or block, and all of its contained information, will be restored to the 
configuration and attached to its original fieldbus or control module. 
 

ATTENTION 
If the fieldbus or control module where the device or block was attached is removed, it will not be 
possible to restore the item. 

 
If the restored item has a duplicated tag, the Tag Table dialog box will open, and the new tag of the 
item will be generated based on the preference set by the user. To edit the tag, right-click the icon of 
the item at the New Tag column and click Rename. Type the new tag and press Enter on the 
keyboard. 
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Deleting Items from the Recycle Bin 
 
When an item is deleted from the Recycle Bin, it is completely removed from the configuration and 
cannot be restored later on. 
 
To remove an item from the Recycle Bin, right-click the icon and click Delete. 
 
To remove all items form the Recycle Bin, right-click the Recycle Bin icon and click Empty 
Recycle Bin. 
 

 
Figure 6.2. Deleting all elements from the Recycle Bin 

 
 

Ordering Items in the Recycle Bin 
 
The items in the Recycle Bin can be ordered by the date and time they were deleted, by the tag or 
by the type of the items. 
 
Right-click the Recycle Bin icon at the Recycle Bin window and select one of the options as 
indicated in the figure below: 
 

 
Figure 6.3. Ordering Items in the Recycle Bin 

 
Sort by deletion time: Select this option to order the blocks, devices and bridges based on the date 
and time they were deleted from the configuration. 
 
Sort by item type: Select this option to order the blocks, devices and bridges alphabetically based 
on the type of the items. 
 
Sort by item tag: Select this option to order the blocks, devices and bridges alphabetically based 
on the tag of the items. 
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SEARCH MENU 
 
You can search for devices and blocks on the strategy configuration. 
 
Go to the Search menu and click Find. The Find Tags dialog box will open: 
 

 
Figure 7.1. Find Tags Dialog Box 

 
To search for a device, click the Device tab and type the tag on the Tag to Find text box, or select 
the tag on the Tags box. The device’s location will be indicated in the Fieldbus Networks Location 
box. 
 
Click Ok to open the Fieldbus window where the selected device is located. 
 
To search for a block, click the Block tab and type the tag on the Tag to Find text box, or select the 
tag on the Tags box. The block’s location will be indicated in the Fieldbus Networks Location box. 
 
The Physical Location box shows to which process cell and control module the block is attached. 
 
Click Ok to open the Fieldbus window and locate the selected block. 
 

 
Figure 7.2. Locating a block 
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Section 8 
 

8.1 

PROPERTIES 
 

Drawing Properties 
 
This section presents a brief explanation about the drawing properties. For example, you can 
change the number of pixels representing a logical measure unit, the background and the grid 
colors, or choose a background image to be placed at the drawing area in the Strategy window. 
 
Right-click the drawing area in the Strategy window and click Drawing Properties. The Drawing 
Properties dialog box will open. 
 

 
Figure 8.1. Drawing Properties Dialog Box 

 
After editing the properties, click Ok to apply the changes and close the dialog box. 
 
Click Apply to apply the changes and show the alterations in the Strategy window without closing 
the Drawing Properties dialog box. It is not possible to undo the changes after clicking this button. 
 
Click Cancel to discard the changes and close the dialog box. ATTENTION! The changes will not 
be discarded if you clicked Apply before clicking Cancel. 
 
 
General Tab 
 
Change the drawing visualization and the total extents of the drawing in the General tab. 
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Figure 8.2. Drawing Properties Dialog Box: General Tab 

 
The Logical Units per Pixel Relationship rectangle defines: 
 

• How many X units will correspond to a determined number of pixels, increasing or 
decreasing the numbers at the X boxes. This will increase the width view. 

• How many Y units will correspond to a determined number of pixels, increasing or 
decreasing the numbers at the Y boxes. This will increase the height view. 

 
Check the Same X and Y Relationship box to maintain the correct proportion between the X 
variable and the Y variable. 
 
At the Total Extents rectangle choose to represent the drawing: 
 

• In Units: you will work in a specific area independently from the paper size, except when 
printing the drawing. In this case, the software will make a correspondence, independent 
of the number of pages it will take. Increase or decrease the number of horizontal and 
vertical units typing or selecting a number at the X and Y boxes. 

• In Printable Pages: the drawing is displayed in a page format, according to the Print 
Setup definitions and pre-defined units size. Define the number of side-by-side pages at 
the Horz box, and the number of pages one after the other vertically at the Vert box. 

 
 
Colors Tab 
 
Change the background and the grid colors of the drawing area in the Colors tab. 
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Figure 8.3. Drawing Properties Dialog Box: Colors Tab 

 
Click the Background rectangle to open the Color box. Select the background color at the palette 
and click Ok. 
 
Click the Grid rectangle to open the Color box. Select the grid color at the palette and click Ok. 
 
 
Helper Tools Tab 
 
In the Helper Tools tab, enable or disable gridlines, change the spacing between gridlines and type 
the zoom factor for the drawing view. 
 

 
Figure 8.4. Drawing Properties Dialog Box: Helper Tools Tab 

 
• Show Grid: check this box to show the grid points at the Strategy window. 

• Snap to Grid: check this box to make the objects snap to the grid. 

• Show Page Breaks: check this box to view horizontal and vertical page breaks according 
to the number of horizontal and vertical pages defined in the Printable Pages option in the 
General Tab. 
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At the Grid Spacing rectangle, define the space between gridlines, increasing or decreasing the 
number of units at the Units box. 
 
At the Zoom Factor rectangle, define the zoom factor typing the number that will determine how 
many times the drawing view will be increased or decreased. 
 
 
Background Image Tab 
 
In the Background Image tab, choose any bitmap to be placed on the drawing background, 
defining its position or stretching it to the window size. 
 

 
Figure 8.5. Drawing Properties Dialog Box: Background Image Tab 

 
Check the Select New Image box to choose a bitmap as the background image. The Open dialog 
box will open to select the file. 
 
Check the Delete Current Image box to delete the bitmap currently used on the drawing area. 
 
Check the Uses Transparency box to select one color from the bitmap as transparent. Click the 
Color rectangle to open the palette and select the color. 
 
You can also define the view properties, such as placing image at a determined position, or 
stretching it to the window size: 
 

• Center Image: places the bitmap at the center of the drawing area. 

• Stretch Image to Window Size: stretches the bitmap image to fit the window size. 

• Stretch Window to Image Size: stretches the drawing area window to fit the bitmap 
image. 

• Place Image At: defines a position for the bitmap image inside the drawing area. To define 
the horizontal position, select the value at the X box. To define the vertical position, select 
the value at the Y box. 

 
At the Settings Above For rectangle, select the option Whole Drawing to apply the bitmap position 
to the whole drawing area, or select Each Printable Page to apply the bitmap position for each 
printable page. 
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Object Properties 
 
This section presents a brief explanation about the object properties. For example, you can change 
the position, size, line color, fill color and text attributes of the block in the Strategy window. 
 
Right-click the block or object in the Strategy window and click Properties. The Object Properties 
dialog box will open. 
 

 
Figure 8.6. Object Properties Dialog Box 

 
After editing the properties, click Ok to apply the changes and close the dialog box. 
 
Click Apply to apply the changes and show the alterations in the Strategy window without closing 
the Object Properties dialog box. It is not possible to undo the changes after clicking this button. 
 
Click Cancel to discard the changes and close the dialog box. ATTENTION! The changes will not 
be discarded if you clicked Apply before clicking Cancel. 
 
The Line, Fill and Text Attributes tabs have three additional buttons, which will be available when 
changing at least one attribute from the object: 
 

• Inherit: apply the default configuration to the object. 

• Revert: revert the settings to the previous configuration. 

• Set As Default: set the current configuration as the default settings. 
 
 
General Tab 
 
In the General tab, you can precisely change the position and the size of the selected object. The 
Status bar, at the bottom of the Syscon window, displays information about the location of the 
cursor, while moving the cursor on the Strategy window. 
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Figure 8.7. Object Properties Dialog Box: General Tab 

 
At the Position rectangle: 
 

• Define the horizontal position of the object selecting the number at the X box. 

• Define the vertical position of the object selecting the number at the Y box. 
 
At the Size rectangle: 
 

• Define the width of the object selecting the number of horizontal units at the Width box (the 
minimum width is 75 units). 

• Define the height of the object selecting the number of vertical units at the Height box (the 
minimum height is 44 units). 

 
 
Line Tab 
 
In the Line tab, change the attributes of the line for the selected object. 
 

 
Figure 8.8. Object Properties Dialog Box: Line Tab 

 
At the Thickness rectangle, define the line thickness selecting the number. Examples: 
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Figure 8.9. Line Thickness 

 
At the Style rectangle, click the down arrow to select the line style: dashed line, doted line, dashed-
dot line, dashed-dot-dot line, or solid line, which is the default. Examples: 
 

 
Figure 8.10. Line Styles 

 
At the Color rectangle, click the rectangle to open the Color box and select the color at the palette. 
Examples: 
 

 
Figure 8.11. Line Colors 

 
Fill Tab 
 
In the Fill tab, change the fill attributes for the selected object. 
 

 
Figure 8.12. Object Properties Dialog Box: Fill Tab 

 
Select one of the options to define the fill effect: Hollow, Solid or Hatched. 
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The Style rectangle is only available for the Hatched fill style. See the following examples of fill 
styles: 
 

 
Figure 8.13. Fill Effects 

 
The Color box is available for the Solid and Hatched fill style. Click the rectangle to open the Color 
box, select the color at the palette and click OK. 
 
 
Text Attributes Tab 
 
In the Text Attributes tab, change the attributes of the text for the selected object. 
 

 
Figure 8.14. Object Properties Dialog Box: Text Attributes Tab 

 
Select one of the options: 
 

• Full Quality: this option limits the text to work with Windows restricted attributes. You won’t 
be able to handle the text as an object, resizing or changing the line or fill attributes. 

• Fully Resizable: this option enables changing any text attribute as an object. 
 
Choose the background style for the text: 
 

• Transparent: set a transparent background for the text. 

• Opaque: set a filled background for the text. 
 
The Background Color rectangle is available for the Opaque text background. Click rectangle to 
open the Color box. Select the color at the palette and click Ok. 
 
The Font button opens the Font dialog box. Select the type, style, and size of the text, and click Ok 
to conclude. 
 
Select the alignment for the text: click Left to align the text to the left; click Center to center the text; 
or click Right to align the text to the right. 
 



Section 9 
 

9.1 

TOOLBARS 
 
To activate a toolbar, go to the Tool menu, select Tool Boxes and click the option related to the 
toolbar. A check mark appears next to the toolbar when the toolbar is displayed. 
 
The toolbars are placed at the left side of the Syscon window, but you can drag the toolbar to any 
location in the window. The Tool Boxes menus list the same functionalities available on the 
toolbars. 
 
 

Main Toolbar 
 
The main toolbar is automatically activated with Syscon. 
 

 
Figure 9.1. Main Toolbar 

 

 - New Button 
Click this button to create an area. See section Creating an Area. 
 

 - Open Button 
Click this button to open an area. See section Opening an Area. 
 

 - Save Button 
Click this button to save a strategy configuration or a template file. See section Saving an Area. 
 

 - Cut Button 
Click this button to remove an object from the area and place it on the clipboard. 
 

 - Copy Button 
Click this button to copy the selection to the clipboard. 
 

 - Paste Button 
Click this button to insert the contents of the clipboard at the insertion point. This command is 
available after cutting or copying an object. 
 

 - Print Button 
Click this button to print the strategy configuration or the drawing objects at the Strategy window. 
See section Printing the Strategy Configuration. 
 

 - Print Preview Button 
Click this button to see how the strategy configuration will look when printed. You can change the 
printer configuration and select the objects to be printed. See section Print Preview. 
 

 - View/Edit Mode Button 
Click this button to toggles between the View mode and the Edit mode. This button is only enabled 
when the Database Manager is running and Syscon is operating in Multi-User mode. 
 

 - Commit Button 
Click this button to send the current configuration to the Database Manager. 
 
This button is only available when Syscon is operating in Multi-User mode and the 
communication to the plant is Offline. 
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 - Revert Button 
Click this button to discard the alterations in the current configuration and restore the original 
configuration from the Database Manager. 
 
This button is only available when Syscon is operating in Multi-User mode and the 
communication to the Plant is Offline. 
 

 - Online Button 
Click this button to initialize the communication. When selected, Syscon is operating in Online 
mode. 
 

 - Refresh Button 
Click this button to update the information displayed in Syscon. This button will only be enabled 
when the communication is online, and it is available for the main window, the Fieldbus window, the 
Live List and Block List window. 
 

 - Error Log Button 
Click this button to open the Error Log window. The Error Log window reports the errors that 
occurred during the communication. 
 

 - Show/Hide Button 
Click this button to show or hide detailed information about block types, blocks parameters, devices 
types and fieldbus macrocycle. 
 

 - Contents Button 
Click this button to open the Syscon Help Contents. 
 
 

Strategy Toolbar 
 
The Strategy toolbar is displayed when the Strategy window is opened. Use these tools to create 
and manipulate blocks, links and strategy templates. 
 

 
Figure 9.2. Strategy Toolbar 

 

 - Select Button 
Click this button to select any object(s) at the Strategy window for moving, resizing, editing tags, etc. 
 

To select a single object at the Strategy window, click Select  and click the object. 
 

To select more than one object at the Strategy window, click Select , press and hold down the 
Shift key on the keyboard, and click the objects to be selected. Or click the drawing area, hold the 
mouse button down while dragging a rubber band around the objects to be selected. 
 

 - Modify Button 
Click this button to change the shape of an object, to redraw the link line, or change the label of a 
parameter, a link or a block. 
 
To use this tool, first select the object then click the Modify button. Click any corner of the object 
and drag the cursor to obtain the new figure. See the following illustration: 
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To redraw the link line, click Select  to select the link and click Modify . Click the link line to 
create a Modifying corner or right-click the Modifying corner to remove it from the link line. Click the 
corner and drag it to redraw the link. 
 

 
 
If the current corner is set as the reference point, hold down the Ctrl key while dragging the corner 
to draw it at the same horizontal or vertical direction. Hold down the Shift key while dragging the 
corner to draw it at a diagonal direction. 
 
If the previous corner is set as the reference point, hold down the Ctrl key while dragging the corner 
to draw a horizontal or vertical line from the previous corner. Hold down the Shift key while dragging 
the corner to draw a diagonal line from the previous corner. 
 
If the next corner is set as the reference point, hold down the Ctrl key while dragging the corner to 
draw a horizontal or vertical line from the next corner. Hold down the Shift key while dragging the 
first corner to draw a diagonal line from the next corner. 
 

 
 
To modify the label from the parameter, block, or link, click Modify and click the label. Type the new 
label and click the drawing area to conclude. When a block label changes, the block tag is 
automatically updated in the Process Cell window and the Fieldbus window. The parameter label 
does not change in these windows. 
 

 - Function Block Button 
Click this button and click the drawing area to create function blocks. The New Block dialog box will 
open. Configure the block attributes and click Ok to add the block to the drawing area. See section 
Creating Blocks in the Strategy Window for details. 
 

 - Link Button 
Click this button to create links between function blocks. Right-click the block, select the Output 
Parameter, right-click another block and select the Input Parameter. See section Creating Links 
for further information. 
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 - Import Strategy Template Button 
Click this button to import a template to the Strategy window. The Open dialog box will appear. 
Select the template file and click Open. The template will be added to the Strategy window. See 
section Import a Template into the Strategy window for further information. 
 

 - Export Selected Strategy as Template Button 
Click this button to create a template file with the selected blocks and links from the Strategy 
window. The Save dialog box will open. Type the name for the template file and click Save. See 
section Exporting a Template from the Strategy window for further information. 
 

 - On Line Monitoring Button 
Click this button to put control strategy into the online mode. 
 
 

Characterization Toolbar 
 
The Characterization toolbar is displayed in the Block Characterization dialog box. 
 

 
Figure 9.3. Online Characterization Toolbar 

 

 - Auto Button 
Click this button to set the value of the Mode Block parameter to Auto. 
 

 - Man Button 
Click this button to set the value of the Mode Block parameter to Manual. 
 

 - CAS Button 
Click this button to set the value of the Mode Block parameter to Cas:Auto. 
 

 - OOS Button 
Click this button to set the value of the Mode Block parameter to OOS. 
 

 - Input Button 
Click this button to display the Input parameters of the block. An input parameter obtains its value 
from a source external to the block. 
 

 - Output Button 
Click this button to display the Output parameters of the block. An output parameter is a parameter 
that may be linked to the input parameter of another block. 
 

 - Contained Button 
Click this button to display the Contained parameters of the block. A contained parameter is a 
parameter whose value is configured, set by an operator, higher-level device or calculated. 
 

 - Confirmed Edition Button 
If this button is highlighted, you will have to click the End Edit button at the bottom of the 
Characterization window to confirm the edition and accept the changes to the parameter value, or 
press Enter on the keyboard. 
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 - Mark to Save Button 
This button is only available in the On Line Characterization Toolbar. 
 
Click this button to save the parameter value even if it was not edited. The parameter will be marked 
with a V in the Changed column. Click this button to also unmark a parameter that changed the 
value but the changes are not to be saved. 
 

 - No Customization Button 
Click this button to display all the parameters read from the DD. 
 

 - Customization By Type (Default) Button 
Click this button to display the parameters selected by Block Type in the Customization dialog 
box. The Default Customization affects all strategy configurations. See section Customize 
Characterization for further details. 
 

 - Show Value as Symbol Button 
Click this button to display the parameter value as a symbol or as a numeric value. 
 

 - DD Help Button 
Click this button to display the DD’s help information about the parameter at the bottom of the 
Characterization window. 
 
 
Right-click the area at the bottom of the Characterization dialog box to open the menu and select 
other options: 
 

 
Figure 9.4. Menu options for the Characterization window 

 
Dynamic: shows the dynamic parameters of the block. Dynamic parameter values are calculated by 
the block algorithm and therefore do not need to be restored after a power failure. 
 
Diagnostic: shows the diagnostic parameters of the block. 
 
Service: shows the service parameters of the block. 
 
Operation: shows the operate parameters of the block. 
 
Alarm: shows the alarm parameters of the block. Alarms and events, known as alerts, represent 
state changes within function block applications. 
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Tune: shows the tune parameters of the block. 
 
Local: shows the local parameters of the block. 
 
Relative Index Column: shows the Relative Index column. 
 
Handling Column: shows the Handling column. 
 
CF Default Value Column: shows the default parameter values defined by the device manufacturer 
in the Capabilities File. 
 
All: shows all parameters read from the DD. 
 
Default: shows the parameters selected by Block Type in the Customization dialog box. 
 
Type: shows the parameters selected by Block Type in the Customization dialog box. The 
Customization By Type affects only the current configuration. 
 
Tag: shows the parameters selected for a specific Block Tag in the Customization dialog box. The 
Customization By Tag affects only the current configuration. 
 
 

Drawing Toolbar 
 
To activate the Drawing toolbar, go to the Tools menu, select Tool Boxes and click Drawing. The 
Drawing toolbar will open: 
 

 
Figure 9.5. Drawing Toolbar 

 

 - Select Button 
Click this button to select any object(s) at the Strategy window for moving, resizing, editing tags, etc. 
Refer to the Select Button on the Strategy Toolbar section. 
 

 - Drawing Modify Button 
Click this button to change the shape of an object, to redraw the link line, or change the label of a 
parameter, a link or a block. Refer to the Modify Button on the Strategy Toolbar section. 
 

 - Rectangle Button 
Click this button to draw a rectangle. Click the drawing area and drag the cursor diagonally in the 
desired direction to obtain the figure. To draw a square, press and hold down the Shift key while 
dragging the cursor. 
 

 
 

 - Rounded Rectangle Button 
Click this button to draw a rounded rectangle. Click the drawing area and drag the cursor diagonally 
in the desired direction to obtain the figure. To draw a rounded square, press and hold down the 
Shift key while dragging the cursor. 
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 - Ellipse Button 
Click this button to draw an ellipse. Click the drawing area and drag the cursor diagonally to obtain 
the figure. To draw a circle, press and hold down the Shift key while dragging the cursor. 
 

 
 

 - Arc Button 
Click this button to draw an arc. Click the drawing area and drag the cursor to obtain the desired 
figure. To draw an arc with the height equals to its width, press and hold down the Shift key while 
dragging the cursor. 
 

 
 

 - Pie Button 
Click this button to draw a pie. Click the drawing area and drag the cursor to obtain the desired 
figure. To draw a pie with the height equals to its width, press and hold down the Shift key while 
dragging the cursor. 
 

 
 

 - Chord Button 
Click this button to draw a chord. Click the drawing area and drag the cursor to obtain the desired 
figure. To draw a chord with the height equals to its width, press and hold down the Shift key while 
dragging the cursor. 
 

 
 

 - Ring Button 
Click this button to draw a ring. Click the drawing area and drag the cursor to obtain the desired 
figure. To draw a ring with the height equals to its width, press and hold down the Shift key while 
dragging the cursor. 
 

 
 

 - Line Button 
Click this button to draw a line. Click the drawing area and drag the cursor to obtain the desired 
figure. To draw a perfectly horizontal or vertical line, press and hold down the Ctrl key while 
dragging the cursor. To draw a perfectly 45-degree diagonal line, press and hold down the Shift key 
while dragging the cursor. 
 

 
 

 - Pipe Button 
Click this button to draw a pipe Click the drawing area and drag the cursor to obtain the desired 
figure. To draw a perfectly horizontal or vertical pipe, press and hold down the Ctrl key while 
dragging the cursor. To draw a perfectly 45-degree diagonal pipe, press and hold down the Shift 
key while dragging the cursor. 
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 - Polyline Button 
Click this button to draw a polyline. Click the drawing area, drag the cursor and click at each corner 
to draw the lines. To draw a perfectly horizontal or vertical line, press and hold down the Ctrl key 
while dragging the cursor. To draw a perfectly 45-degree diagonal line, press and hold down the 
Shift key while dragging the cursor. Right-click the drawing area to conclude. 
 

 
 

 - Polygon Button 
Click this button to draw a polygon. Click the drawing area, drag the cursor and click at each corner 
of the polygon. To draw a perfectly horizontal or vertical line, press and hold the Ctrl key down while 
dragging the cursor. To draw a perfectly 45-degree diagonal line, press and hold down the Shift key 
while dragging the cursor. Right-click the drawing area to conclude the polygon. 
 

 
 

 - Text Button 
Click this button to type any text at the Strategy window. Click the drawing area and the cursor will 
change to a prompt. Type the text and click at the drawing area to conclude. 
 

 - Bitmap Button 
Click this button to import a bitmap file to the Strategy window. Click the drawing area and the Open 
dialog box will appear. Select the bitmap file and click Open. The bitmap has its own settings: 
 

 
 

Uses Transparency: set transparency for the bitmap. 
 
Set Transparent Color: select the transparent color for the bitmap. 
 
Change From File: select another bitmap to replaced the current one. 
 
Save To File: save the bitmap as a .bmp file. 
 
Properties: opens the Object Properties dialog box. See section Object Properties for 
details. 
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Alignment Toolbar 
 
To activate the Alignment toolbar, go to the Tools menu, select Tool Boxes and click Alignment. 
The Alignment toolbar will open: 
 

 
Figure 9.6. Alignment Toolbar 

 
Use these tools to arrange or distribute drawing objects with equal distances from each other, or 
align their edges or centers, vertically or horizontally. 
 

 - Left Button 
Click this button to align the left side of the selected object(s) to the left side of the anchor. First, 
select the object (or objects) to be aligned. Then click the button and click the reference object. See 
the example: 
 

 
 

 - Center Button 
Click this button to align the horizontal center of the selected object(s) to the horizontal center of the 
anchor. First, select the object (or objects) to be aligned. Then click the button and click the 
reference object. See the example: 
 

 
 

 - Right Button 
Click this button to align the right side of the selected object(s) to the right side of the anchor. First, 
select the object (or objects) to be aligned. Then click the button and click the reference object. See 
the example: 
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 - Top Button 
Click this button to align the top of the selected object(s) to the top of the anchor. First, select the 
object (or objects) to be aligned. Then click the button and click the reference object. See the 
example: 
 

 
 

 - Middle Button 
Click this button to align the vertical center of the selected object(s) to the vertical center of the 
anchor. First, select the object (or objects) to be aligned. Then click the button and click the 
reference object. See the example: 
 

 
 

 - Bottom Button 
Click this button to align the bottom of the selected object(s) to the bottom of the anchor. First, select 
the object (or objects) to be aligned. Then click the button and click the reference object. See the 
example: 
 

 
 

 - Center Points Button 
Click this button to align the center of the selected object(s) to the center of the anchor. First, select 
the object (or objects) to be aligned. Then click the button and click the reference object. See the 
example: 
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 - Evenly Spaced - Horizontal Button 
Click this button to distribute the selected objects horizontally and the horizontal distance between 
the edges of all the objects will be the same. This button is enabled for three or more objects. First, 
select all objects to be aligned, and then click this button. See the example: 
 

 
 

 - Evenly Spaced - Vertical Button 
Click this button to distribute the selected objects vertically and the vertical distance between the 
edges of all the objects will be the same. This button is enabled for three or more objects. First, 
select all objects to be aligned, and then click this button. See the example: 
 

 
 
 

Ordering Toolbar 
 
To activate the Ordering toolbar, go to the Tools menu, select Tool Boxes and click Ordering. The 
Ordering toolbar will open: 
 

 
Figure 9.7. Ordering Toolbar 

 
Use these tools to overlap as many drawing objects as desired and rearrange them in the stack. 
 

 - To Front Button 
Click this button to place the selected object in front of other overlapping objects. First, select the 
object and then click this button. 
 

 
 

 - To Back Button 
Click this button to place the selected object behind other overlapping objects. First, select the 
object and then click this button. 
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 - Forward One Button 
Click this button to move the selected object one position forward in the stacking order. First, select 
the object and then click this button. 
 

 
 

 - Backward One Button 
Click this button to move the selected object one position backward in the stacking order. First, 
select the object and then click this button. 
 

 
 

 - Reverse Order Button 
Click this button to reverse the stacking order of two selected objects. First, select the objects and 
then click this button, and the stacking order will be reversed. 
 

 
 

 - In Front Of Button 
Click this button to place the selected object in front of another object in the stack. First, select the 
object to be moved and click this button. Then, click the reference object in the stack to place the 
previously selected object in front of it. 
 

 
 

 - Behind Button 
Click this button to place the selected object behind another object in the stack. First, select the 
object to be moved and click this button. Then, click the reference object in the stack to place the 
previously selected object behind it. 
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Copy Attributes Toolbar 
 
To activate the Copy Attributes toolbar, go to the Tools menu, select Tool Boxes and click Copy 
Attributes. The Copy Attributes toolbar will open: 
 

 
Figure 9.8. Copy Attributes Toolbar 

 
Use these tools to apply the appearance of an object to another object. 
 

 - Same Width Button 
Click this button to copy the width from one object to another. Select the object that will be changed, 
click this button and then click the reference object to conclude. Example: 
 

 
 

 - Same Height Button 
Click this button to copy the height from one object to another. Select the object that will be 
changed, click this button and then click the reference object to conclude. Example: 
 

 
 

 - Same Dimensions Button 
Click this button to copy the width and the height from one object to another. Select the object that 
will be changed, click this button and then click the reference object to conclude. Example: 
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 - Same Pen & Brush Button 
Click this button to copy the line and fill color from one object to another. Select the object that will 
be changed, click this button and then click the reference object to conclude. Example: 
 

 
 

 - Same Font & Colors Button 
Click this button to copy the text font and colors from one object to another. Select the object that 
will be changed, click this button and then click the reference object to conclude. Example: 
 

 
 

 - Same Text Attributes Button 
Click this button to copy the text font, size and colors, from one object to another. Select the object 
that will be changed, click this button and then click the reference object. Example: 
 

 
 

 - Set Attributes As Default Ones Button 
Click this button to set the attributes of the selected object as the default attributes. Select the 
reference object and click this button. All other objects will be drawn with the same line color, fill 
color, text font and text size as the selected object. 
 
 



Section 10 
 

10.1 

DEVICE SUPPORT 
 
 

Including New DD and Capabilities File 
 
The Device Description for a particular device is provided by the device‘s manufacturer and 
distributed by the Fieldbus Foundation. If it is not currently available from the Fieldbus Foundation, 
you may need to contact the manufacturer and get a copy of the DD. 
 
There is a DD for each device type, and it consists of the files whose extensions are “.ffo” and 
“.sym”. 
 
The Capabilities File is used to define the device capabilities – e.g., dynamic block instantiation 
capability - and the resources available for creating Function Block Applications, including Resource 
Blocks, Transducer Blocks, Function Blocks, and Function Block Links. 
 
The Capabilities File consists of the files with the extension “.cff”, and they are placed together with 
the DD files. 
 
The files are organized in the folders for each manufacturer, as the following figure shows: 
 

 
Figure 10.1. Device Support Folders 

 
Syscon needs DD and Capabilities Files in order to configure a device. 
 

IMPORTANT 

The subsections below describe how to create and manage Device Support files. It is strongly 
recommended to use the Import Device Support procedure to include missing files. 
When you manually change the Device Support folder to an inappropriate format, for example, 
renaming folders or files to an unexpected format or even adding additional folders and files, 
Syscon may not operate correctly. 

 
 

Adding DDs and Capabilities Files 
 
Open the Device Support installation folder and create a new folder for the manufacturer if it is not 
there yet. The folder name should be the 6 hexadecimal digits representing the manufacturer’s 
code, for example, the folder 000302 represents SMAR. The default path for the Device Support 
installation folder is C:\Program Files\Smar\Device Support. 
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Inside the manufacturer’s folder, create the Device Type folder. The name for this folder should be 
the 4 hexadecimal digits of the Device Type code, for example, the folder 0001 inside the folder 
000302 represents the LD302. 
 
Copy the DD and the Capabilities Files for the new device to the newly created Device Type folder 
in the Device Support folder. 
 
After that, Syscon will be able to reference the new DDs in the dialog boxes when creating devices 
and blocks, indicating the Manufacturer ID and the Device Type code. 
 
However, Syscon will not be able to show the manufacturer name or the device name, because you 
must define them in the Device Support.ini file. If the device supports dynamic instantiation of 
function blocks, you must define the Function Block Mnemonics. If the Capabilities File is not 
provided, you can define it since the necessary information is available. For details on defining 
manufacturer and device names, creating capabilities files, and defining block mnemonics, refer to 
the SYSTEM302 Handbook. 
 
 

Importing Files for H1 Devices 
 
Syscon can automatically import the DD and CF files of SE devices, that is, field devices and 
bridges for H1 fieldbuses. This procedure will execute the steps to include a new DD and CF, define 
the manufacturer, the device name, and the block mnemonics. 
 
Using this procedure to import files will add another step, which is to verify the CF file and abort the 
import operation if the CF file does not have the mandatory information or has the wrong information 
according to the FF-103 Foundation Specification Common File Format. This process assures that 
the device and block creation in Syscon is successful. 
 

IMPORTANT 

You must be logged as the Administrator or a member of the Administrators group to import 
Device Support files. 

 
On the Project File menu, click Import Device Support. The Browse dialog box will open. Select 
the directory where the DDs and CFs of the device being imported are located and click Ok. 
 
The Import Device Support dialog box will open showing the list of files that will be imported in the 
Device Support folder of the corresponding manufacturer: 
 

 
Figure 10.2. Confirming the files to be imported 

 
Click Ok and a message box will appear informing the user that the operation was successful. Click 
Ok to conclude. 
 



Device Support 
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Importing Files for HSE Devices 
 
Syscon imports DD and CFH files of HSE controllers and devices. This procedure is similar to the 
steps described to import DD and CF files for SE devices. 
 
On the Project File menu, click Import Device Support. Select the directory where the DDs and 
CFHs are located and click Ok. The Import Device Support dialog box will open showing the list of 
files that will be imported in the Device Support folder of the corresponding manufacturer. 
 
Click Ok and a message box will appear informing the user that the operation was successful. Click 
Ok to conclude. 
 
 

Importing Files for Linking Devices with no FBAP 
 
When importing CFH files for pure Linking Devices without FBAP, it will be necessary to define the 
Manufacturer ID and the Device Type ID for that equipment. 
 
On the Project File menu, click Import Device Support. The Browse dialog box will open. Select 
the directory where the CFH files being imported are located and click Ok. 
 
On the dialog box, type the hexadecimal numbers related to the Manufacturer ID and the Device 
Type ID for the equipment. Click Ok to proceed. 
 

 
Figure 10.3. Importing CFH files 

 
NOTE 

Hexadecimal numbers related to the Manufacturer ID and the Device Type ID for instruments 
can be found at the Fieldbus Foundation website (http://www.fieldbus.org), on the same page 
where CFH files for linking devices can be downloaded. 

 
Confirm the information related to the Linking Device and click Ok. The files will be imported in the 
Device Support folder of the corresponding manufacturer. 
 
 

Checking Missing Device Support 
 
Every time you open a project configuration file, Syscon verifies if the DDs and Capabilities Files 
used in the configuration are installed with the application. 
 
A message box opens informing the user if one or more files are missing. 
 

 
Figure 10.4. Checking Missing Device Support 
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Click Yes on the message box to open the Locate Missing Device Support Files dialog box: 
 

 
Figure 10.5. Displaying the Missing Files 

 
If you click No, and Syscon will open the configuration file, but some blocks and parameters will not 
be available. 
 
The following sub-sections describe the steps to locate missing Device Support files. 
 
 
Locating the Missing Files Manually 
 

IMPORTANT 

You must be logged as the Administrator or a member of the Administrators group to copy the 
DD and CF files to the Device Support. 

 
On the Locate Missing Device Support Files dialog box, right-click the file icon and click Locate: 
 

 
Figure 10.6. Locating the Missing Files 

 
The Browse dialog box will open. Browse the directories to select the folder where the DD and CF 
files are located. 
 
Click Ok and Syscon will automatically create the device folder copying the DDs and CFs. 
 
Repeat this procedure for each file listed on the Locate Missing Device Support Files dialog box. 
After locating all missing files, click Close to return to Syscon and open the configuration file. 
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Generating the DSM File 
 
The Device Support Maintenance file, DSM file, contains the list of support files that are missing in 
the configuration. 
 

IMPORTANT 

You must be logged as the Administrator or a member of the Administrators group to create 
the DSM file and copy the DD and CF files to the Device Support. 
The support files related to the Flexible Function Blocks will not be included in the DSM file. 

 
In the Locate Missing Device Support Files dialog box, click the button Generate DSM to open 
the Browse dialog box. Select the folder where the DSM file will be saved and click Ok. 
 
A message box will appear informing the user that the operation was successful. Click Ok to return 
to the Locate Missing Device Support Files dialog box and then click Close. 
 
The DSM file should be sent to the machine that has the missing DDs and CFs, usually the 
machine where the configuration was originally created. See section Packing the Missing Device 
Support Files. 
 
When you receive the pack with the DD and CF files, in a directory named Missing Files, import 
these files to the target machine. See section Importing Missing Device Support Files. 
 
 
Packing the Missing Device Support Files 
 
To create a package with the missing DD and CF files, it is necessary to send the DSM file 
generated in the machine where the files are missing to a machine that has a consistent Device 
Support directory. 
 

IMPORTANT 

You must be logged as the Administrator or a member of the Administrators group to copy the 
DD and CF files. 
The support files related to the Flexible Function Blocks will not be included in the DSM file. 

 
Open Syscon, go to the Project File menu and click Pack Missing Device Support. The Open 
dialog box will appear. Browse the directories to locate the DSM file, select its icon and click Open. 
 
The Browse for Folder dialog box will open. Select the directory where the package with the 
missing files will be created and click Ok. 
 
A message box will appear informing the user that the operation was successful and the folder 
Missing Files was created. 
 
Click Ok to conclude. 
 
The folder Missing Files should be sent to the machine where the DDs and CFs are missing. See 
section Importing Missing Device Support Files below. 
 
 
Importing Missing Device Support Files 
 
Syscon can automatically import DD and CF files of a device missing in the configuration project, 
using the DSM file. This procedure locates the DSM file and the Missing Files directory to include 
the DDs and CFs, defining the manufacturer and the device name. 
 
 

IMPORTANT 

You must be logged as the Administrator or a member of the Administrators group to import 
the Device Support files. 

 



SYSCON 6.5 - User’s Manual 
 

10.6 

 
In the Locate Missing Device Support Files dialog box, click the button Import DSM. The Open 
dialog box will appear. Browse the directories to locate the Missing Files folder, select the DSM file 
and click Open. 
 
A message box will appear informing the user that the operation was successful. Click Ok and then 
click Close in the Locate Missing Device Support Files dialog box to return to the application and 
open the configuration file. 
 
 



Section 11 
 

11.1 

TUTORIAL: MAPPING TOOL 
 

Introduction 
 
Mapping Tool integrates Profibus and DeviceNet configurations created in the application Network 
Configurator, AS-i configurations created in the Network Configuration Tool, and Modbus 
configurations created in the Smar Network Configuration - Modbus Tool, to project 
configurations created in Syscon. 
 
The table below lists terms and definitions used in this tutorial: 
 

Standard I/O 
Connection 

Input or output bytes that are automatically mapped as a Function Block 
(with Parameters) and/or I/O Point Group (with I/O Points). 

Non-Standard 
I/O Connection 

Input or output bytes that can be mapped as a Function Block (with 
Parameters) and/or I/O Point Group (with IO Points) by the user, in an 
interactive process. 

Controller A CPU with the same functionalities of Gateway, Linking Device, Remote 
I/O, logical controller, etc. 

I/O Point Mapped representation of a physical I/O point. 

I/O Point Group One or more groups of I/O Points defined for each network device. I/O 
Point Group may or may not be associated to a Function Block by its tag. 

 
In brief, you must first create an HSE project in Syscon, open the HSE Network window, and then 
add a Profibus, DeviceNet, AS-i or Modbus controller in the HSE channel. Return to the Project 
window, right-click the controller icon and select the option New Network to create a network 
configuration. See the example below: 
 

 
Figure 11.1. Creating a Network Configuration 

 
This network is configured in Network Configurator, where you can define the Profibus or 
DeviceNet bus structure, that is, type of connections, baud rate and devices connected to the 
network. To define the AS-i bus structure, the Network Configuration Tool will be executed. To 
define the Modbus bus structure, the SmarNetConf - Modbus Tool will be executed. 
 
To create a Profibus, DeviceNet, AS-i or Modbus network, configure the master controller, add slave 
devices and configure the parameters. For further information, refer to the Help file in Network 
Configurator and Network Configuration Tool. 
 
After configuring the network, save the changes, close the corresponding configuration tool and 
return to Syscon. Then, Mapping Tool is started automatically. It opens the network configuration 
file, validates all tags of each slave device and creates the topology tree that represents the 
controller and devices in the network within the project configuration in Syscon. 
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This tool also identifies, for each device, Standard I/O Connections and maps them as Function 
Blocks and/or I/O Point Groups. Tags from each Function Block, IO Point Groups and I/O Points are 
also set by Mapping Tool. 
 
By now, Mapping Tool shows the controller, network devices, Function Blocks and I/O Point 
Groups, standard and non-standard I/O connections, and the Memory Map when an I/O Connection 
or I/O Point is selected. 
 
The example in the figure below shows the Mapping Tool window: 
 

 
Figure 11.2. Mapping Tool Window 

 
To map I/O Points after creating a Profibus, DeviceNet or AS-i network and closing Mapping Tool, 
right-click the icon of the Profibus, DeviceNet or AS-i network, in the corresponding network window 
as indicated below, and select the option Modify I/O Mapping. 
 

 
Figure 11.3. Opening the Mapping Tool window 

 
The sections below describe the Mapping Tool interface and procedures for mapping input and 
output I/O points. 
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User Interface 
 
The following table shows the icons that graphically represent the network topology, in the Mapping 
Tool window: 
 

 Profibus, DeviceNet or AS-i Controller 

 Network Channel 

 Profibus, DeviceNet or AS-i Device 

 I/O Connection List 

 I/O Connection List with unmapped connections 

 Mapped I/O Connection 

 Unmapped I/O Connection 

 Function Block 

 Parameters and I/O Points 

 I/O Points Group 

 
Below the Network Topology View area, the I/O Point data type and bit/byte offset is indicated. 
Right below the Function Block View area, the total number of blocks is indicated, and below the 
I/O Point Group View area the total number of I/O points created, and the numbers of available 
analog and discrete I/O points are also indicated for the entire configuration displayed in the network 
topology tree. 
 
 
Network Topology View 
 
The Network Topology View shows the current network configuration, created with Network 
Configurator. It is not possible to edit the network configuration topology in Mapping Tool, only I/O 
connection mapping can be altered. 
 

 
Figure 11.4. Network Topology View 
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For example, click the icon of a mapped I/O connection on the Network Topology View to display 
the memory map, function blocks and I/O points related to that I/O connection. 
 
 
Expanding the Network Topology 
 
In order to better organize the network topology view, you can expand or collapse elements from a 
selected item. 
 
You can expand or collapse the elements in the Network Topology View area. First, select the 
item, such as a module, controller, instrument or connections. On the View menu, click the option 
Collapse to collapse sub-elements from the selected item, or press CTRL + NumPad- on your 
keyboard. On the View menu, click the option Expand to display the sub-elements from the 
selected item, or press CTRL + NumPad+ on your keyboard. 
 
 
Memory Map View 
 
The Memory Map View shows byte positions of the I/O connection selected in the topology network 
tree. Each byte is represented by a different color, where: 
 

 White Byte: indicates that the memory position is available. Click on it to map I/O points; 

 Grey Byte: indicates that the memory position is not available; 

 Light Blue Byte: byte mapped as analog; 

 Dark Blue Byte: byte mapped as analog and the corresponding I/O point is selected; 

 Light Yellow Byte: byte mapped as digital; 

 Dark Yellow Byte: byte mapped as digital and the corresponding I/O point is selected. 
 

 
Figure 11.5. Example of Memory Map View 

 
 
Blocks and Parameters View 
 
The Function Block View lists function blocks and parameters related to the icon selected in the 
network topology tree. For example, when the icon of the controller is selected, blocks and 
parameters of all devices connected to the channels from that controller are listed. Likewise, when 
the icon of the device is selected, only the blocks and parameters configured for that specific device 
are listed. 
 
When you select a parameter in the Function Block View, the related memory map is displayed, 
and mapped bytes are indicated in blue for analog bytes, or yellow for discrete bytes. 
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Figure 11.6. Mapping for the Selected Parameter 

 
 
I/O Point Group View 
 
The IO Point Group View shows the I/O points grouped by device, according to the icon selected in 
the topology tree. Similarly to the Function Block View, select the icon of the I/O point to display 
the related memory map. Mapped bytes are displayed in blue, for analog bytes, or yellow for 
discrete bytes. 
 
 
Displaying the Device Model 
 
To indicate the model of each device in the Network Topology, select the View menu and click the 
option Device > Model. The device model is displayed in parenthesis. See the example below: 
 

 
Figure 11.7. Display Device Model 

 
 
Displaying I/O Points Tags 
 
By default, when Mapping Tool is executed, the User Tag of the I/O Points is always displayed. 
The User Tag is defined by the user in Syscon, through the procedure Edit User Parameter Tags. 
 
On the View menu, click the option I/O Point > Tag to display the tags that were automatically 
created by the Mapping Tool for the I/O Points. These tags are indicated in parenthesis. Unmark 
this option to hide these tags.  
 
On the View menu, click the option I/O Point > User Tag to display only the tags defined by the 
user. 
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Using Mapping Tool 
 
Renaming Blocks or I/O Point Groups 
 
You can change the tag of a block or I/O point group using Mapping Tool. Right-click the icon of the 
block or I/O point group and select the option Rename. Type the new tag for the block (or group) 
and click Ok. 
 

 
Figure 11.8. Changing Block Tag 

 
A quick way to edit tags is clicking the icon of the block or I/O point group to select it, and then press 
F2 on your keyboard. The icon text will be enabled for edition. Type the new tag for the block (or 
group) and press Enter on your keyboard. To cancel the alteration, press Esc on your keyboard. 
 
The tag of the I/O Point Group based on the selected block is updated as well. The changes are 
also applied to the strategy configuration, in Syscon. Moreover, the I/O points must be updated in 
the logic project file related to that block, if the logic was created in LogicView. When the user 
opens a logic configuration file in LogicView, or if there is another user editing the file when the tag 
was changed, a message box warns the user to update the configuration file. 
 
If the renamed group has a block associated to it, the block tag is also updated. 
 
 
Removing a Block or I/O Point Group 
 
To remove a block or I/O point group, right-click the icon and select the option Delete. Or click to 
select the icon and press Del on your keyboard. 
 
A message box will open to confirm the operation. Click Ok to remove the selected block or I/O 
point group, or click Cancel to abort the operation. 
 
I/O points are not removed from the I/O connection in Mapping Tool, but the I/O points associated 
to the block are removed and the block is deleted from the Syscon project configuration. If I/O 
points associated to the block were being used in a logic configuration in LogicView, they are also 
deleted from the logic. 
 
 
Removing Several Blocks 
 
To remove two or more blocks at the same time, click a block icon on the Function Block View to 
select it, and then press and hold the Ctrl key on your keyboard while clicking on other block icons 
to select them. 
 
To remove all blocks from the configuration, click a block icon on the Function Block View to select 
it, and press Ctrl + A on your keyboard to select all block icons from the selected I/O connection. 
See the example below: 
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Figure 11.9. Selecting Several Blocks 

 
Press Del on your keyboard. A message box will open to confirm the operation. Click Ok to remove 
the selected blocks, or click Cancel to abort the operation. 
 
I/O points are not removed from the I/O connection in Mapping Tool, but the I/O points associated 
to the block are removed and the block is deleted from the Syscon project configuration. If I/O 
points associated to the block were being used in a logic configuration in LogicView, they are also 
deleted from the logic. 
 
 
Removing I/O Points 
 
To remove an I/O point, right-click the icon and select the option Delete. Or click to select the I/O 
Point icon and press Del on your keyboard. 
 
To remove two or more I/O points at the same time, click an I/O point icon to select it, and then 
press and hold the Ctrl key on your keyboard while clicking on other I/O point icons to select them. 
 
To remove all I/O points from an area, click an I/O point icon to select it, and press Ctrl + A on your 
keyboard to select all I/O point icons. 
 
I/O points are selected according to the area where the first I/O point was originally selected. For 
instance, if an I/O point is selected on the IOGroup Point View, all other I/O points from the same 
group will be selected. See the example below: 
 

 
Figure 11.10. Selecting Several I/O Points 

 
ATTENTION 

If an I/O point is selected on the Network Topology View, all other I/O points from this network 
topology will be selected to be removed. 

 
Press Del on your keyboard. A message box will open to confirm the operation. Click Ok to remove 
the selected I/O points, or click Cancel to abort the operation. 
 
I/O points are removed and deleted from the Syscon project configuration. If the I/O points were 
being used in a logic configuration in LogicView, they are also deleted from the logic. 
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Mapping I/O Connections 
 
Select the icon of an I/O connection to map it as an I/O point and the memory map is displayed in 
the Mapping Tool window, indicating available memory positions and positions that are already 
mapped. Click an available position represented by a white byte to open the Map Wizard dialog 
box. 
 

 
Figure 11.11. Map Wizard Dialog 

 
Select a data type. According to the selected data type, you will then select the block type. And, 
according to the selected block type, you can type the tag for the block or for a group of I/O points. 
 
If data type Bit (discrete) is selected, click Next and set the bits that represent I/O points. Click Next 
and you can type the user tags. Click Finish to conclude. 
 

 
Figure 11.12. Mapping Bits 

 
If analog data type is selected, click Next, configure values for scale parameters (Sensor, PV and 
Unit) and click Finish to conclude. 
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Figure 11.13. Scale Configuration 

 
If discrete data type is selected, except Bit type, just click Finish to conclude. 
 

ATTENTION 

The maximum size for a block or I/O point group tag is 32 characters. The block or I/O point 
group tag must be unique within Studio302 Database. 
I/O Points Tags edited by the user follow the format below: 

• Analog Input: <Device_Tag>_AI_# 
• Analog Output: <Device_Tag>_AO_# 
• Discrete Input: <Device_Tag>_DI_# 
• Discrete Output: <Device_Tag>_DO_# 

Mapping Tool automatically creates tags for I/O points according to the standard format 
described below: 

• Analog Input: IN_# 
• Analog Output: OUT_# 
• Discrete Input: IN_D# 
• Discrete Output: OUT_D# 

 
 
Editing Digital Bits 
 
On the Memory Map View area, click the bit mapped as a digital I/O point to open the Map Wizard 
dialog box. Remember that digital bytes are represented in yellow. See the example below: 
 

 
Figure 11.14. Editing bits 
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Select the bits to represent the I/O point and click Finish to conclude. 
 
 
Editing I/O Point Attributes 
 
Right-click the icon of an I/O point and select the option Attributes to open the Attributes dialog 
box. You can change the user tag of an I/O point, which is indicated in parentheses in the Mapping 
Tool window, and type a brief description for value and status of the I/O point: 
 

 
Figure 11.15. Changing Attributes 

 
If an I/O point is an analog data type, you can also configure the scale values. Right-click the icon of 
an I/O point and select the option Scale. 
 

 
Figure 11.16. Changing Scale Values 

 
 
Editing I/O Point Attributes in the I/O Point Table 
 
Use the I/O Point Table to edit attributes of all I/O points, from every device displayed in the network 
topology tree. On the Edit menu, click the option I/O Point > User Tags to open the I/O Point Table. 
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Figure 11.17. I/O Points Table 

 
You can change user tags and also type value and status descriptions for I/O points. Select a cell on 
the table and double-click it to edit the attribute. When you finish editing the data, press Enter on the 
keyboard to conclude. 
 

 
Figure 11.18. Editing the I/O Points Table 

 
Click Ok to close the I/O Points Table window and return to Mapping Tool. 
 
 
Copying Attributes in the I/O Point Table 
 
In the I/O Point Table, you can copy the attribute or a group of attributes related to one device, and 
paste the same text to other devices, but remember that the tag of a block or I/O point group must 
be unique in the Studio302 Database. 
 

1) Click the cell that contains the attribute to be copied. If you want to select a group of 
attributes to be copied, click the first cell on the table and drag the mouse cursor over the 
desired cells. 

2) Right-click the cells and select the option Copy, or press CTRL + C on the keyboard. 

3) Click the cell where the attribute will be pasted. If you selected a group of cells, it is only 
necessary to click the first cell of the group where the attributes will be pasted. 

4) Right-click the cell and select the option Paste, or press CTRL + V on the keyboard. The 
attributes will be altered according to the number of cells selected. 

5) Press ESC on the keyboard to deselect the copied cells. 
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IMPORTANT 

Remember that the tag of I/O points must be unique in the Studio302 Database. Mapping Tool 
verifies if tags created in the User Tag column do not repeat. 
When you execute the steps above to copy User Tags to other I/O Points, at least part of the text 
must be altered to differentiate I/O points, for example, changing the name of the corresponding 
device. 
Consequently, when you copy and paste user tags, the Find & Replace dialog box opens. On 
the Text to find field, type the text to be searched in the attribute strings from the selected cells. 
On the Text to replace field, type the new text to replace part of the string. Click Ok to replace 
the text strings. 

 
Click Ok to close the I/O Points Table window and return to Mapping Tool. 
 

NOTE 

Another fast way to edit data related to I/O points is using an MS Excel worksheet, considering 
the column order User Tag, Value Description and Status Description, as indicated in the 
example below: 

 
Figure 11.19. Editing I/O Points Using Excel 

Type the desired information, select the cells on the table and click Copy , or press Ctrl+C on 
the keyboard. Return to the Mapping Tool window and select the field corresponding to the first 
point edited in the Excel table, on the column User Tag. Press Ctrl+V on the keyboard. 
Remember that the tag of an I/O point group must be unique in the Studio302 Database. 
Mapping Tool verifies if tags created in the User Tag column do not repeat, and alerts the user 
if a tag is not unique. Tags created by users that already exist in the configuration are not copied 
to the I/O Points Table. 

 
 
Editing Scale Values 
 
On the Edit menu, click the option I/O Point > Scales to edit scale values for all I/O points, from 
every device displayed in the network topology tree. The Edit Scale dialog box will open. 
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Figure 11.20. Editing Scale for I/O Points 

 
To edit a scale value, double-click the cell on the table, or press F2 on the keyboard. Type the new 
value and press Enter on the keyboard to apply the changes. 
 
Click Ok to close the I/O Points Scale Table window and return to the Mapping Tool. 
 
 
Copying Values in the Scale Table 
 
In the Scale Table, you can copy the value or a group of values, and paste them to other I/O points. 
 

1) Click the cell that contains the scale value to be copied. If you want to select a group of 
values, click the first cell of the group on the table and drag the mouse cursor over the 
desired cells. 

2) Right-click the cells and select the option Copy, or press CTRL + C on the keyboard. 

3) Click the cell where the attribute will be pasted. 

If you selected a group of cells, it is possible to paste the values to a proportional number of 
cells. Click the first cell where the value will be pasted and drag the mouse cursor to select 
a multiple number of cells, for example, if you selected two columns and two rows to be 
copied, then you can paste the values to a group of four rows and two columns, or four 
rows and four columns, etc. 

4) Right-click the cell and select the option Paste, or press CTRL + V on the keyboard. The 
values will be pasted to all table cells selected. 

5) Press ESC on the keyboard to deselect the copied cells. 

 
To alter the scale unit for I/O Points, double-click the cell on the Unit Index column corresponding to 
the desired I/O Point. Locate the scale unit on the drop-box menu and click to select it. Use the 
steps describe above to copy and paste the scale unit to several I/O Points. 
 
Click Ok to close the Scale Table and return to the Mapping Tool. 
 
 
Searching Text in the I/O Point or Scale Tables 
 
To search a text or part of a text in the I/O Point Table or in the Scale Table, right-click the table and 
select the option Find. The Find dialog box will open. 
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Figure 11.21. Searching a Text 

 
Type the text on the Find field and click Find. Mark the option Case sensitive to differ uppercase 
and lowercase letters on the search. Mark the option Backward to invert the search direction. 
 
Click Close to conclude. 
 
 
Find and Replace a Text in the I/O Point or Scale Tables 
 
To search a text or part of a text in the I/O Point Table or in the Scale Table, and then replace it with 
another text, first select the cells to be searched. Click the first cell of the group and drag the mouse 
cursor to select the group of cells. Right-click the table and select the option Replace. The Find & 
Replace dialog box will open. 
 

 
Figure 11.22. Replacing a Text 

 
On the Text to find field, type the text to be searched on the table. On the Text to replace field, 
type the new text to replace part of the string. 
 
Click Ok and each occurrence of the searched text will be replaced with the new text. 
 
 
Defining the Reading Order for Bytes 
 
According to the operational system being used, it is necessary to consider the byte order in which 
values are stored in memory. There are two possible reading/writing orders for bytes: 
 

Little Endian: the least significant value in hexadecimal is stored in memory at the lowest 
address; the other bytes will be stored in ascending order until the most significant byte is stored 
in the highest address. This method is also called reverse order. 

 
Big Endian: the high-order byte is stored in memory first, that is, at the lowest memory address. 
The least significant byte is stored at the highest address. 

 
Right-click the icon of a device and select the reading order Little Endian or Big Endian. 
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Figure 11.23. Reading Order 

 
Copying the Memory Map 
 

The memory map of the I/O connection (represented by the icon  in the network topology tree) 
can only be copied to another I/O connection of the same type (an input or output connection). The 
target I/O connection must have a number of bytes available to map the points of the original I/O 
connection. 
 
Likewise, the memory map of a module can only be copied to another module, and the memory map 
of a device can only be copied to another device. 
 

ATTENTION 

It is not possible to copy the memory map for devices with automatic I/O mapping (Standard I/O 
Connection). 

 
Right-click the icon of the desired I/O connection, or module, or device, and select the option Copy 
Mapping. 
 

 
Figure 11.24. Copying the Memory Map 
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Then, right-click the icon of the target I/O connection, or module, or device, of the same type and 
select the option Paste Mapping to conclude. 
 

 
Figure 11.25. Pasting the Memory Map 

 
The I/O Point mapping is copied to the target selected item and the tags of the parameters are 
automatically created. 
 

 
Figure 11.26. Copied I/O Connection 

 
The default format of I/O point tag is described in section Mapping I/O Connections. 
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Deleting Mapped Bits 
 
To delete a mapped I/O point, right-click its icon and select the option Delete. 
 

 
Figure 11.27. Deleting Mapped Bits 

 
The selected I/O point is automatically deleted and will be available for new mapping. 
 

ATTENTION 

If the Delete option is not available in the menu, it means mapping was automatically executed 
by Mapping Tool, and it will be necessary to edit the channel or device configuration using the 
Network Configurator tool. 

 
 
Changing I/O Point Offset 
 
You can change the offset from I/O Points that were already mapped. But, it will not be possible to 
change the offset if the I/O points were automatically mapped by Mapping Tool. 
 
To change the offset, right-click the I/O point icon and click the option Change Position. See the 
example below, where the selected analog I/O point is displayed in dark blue on the Memory Map 
View: 
 

 
Figure 11.28. Selecting the I/O Point 

 
The Change Position dialog box will open. Mark the option Change Offset and select the desired 
offset from the list of available positions. See the example below: 
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Figure 11.29. Selecting a New Position 

 
Click Finish to conclude. The select I/O Point will be displayed on the new position, on the Memory 
Map View, as indicated below: 
 

 
Figure 11.30. New I/O Point Offset 

 
If the position of a digital I/O Point is being altered, there will be another step on the Change 
Position dialog box. First, mark the option Change Offset and select the desired offset from the list 
of available positions. Click Next, select the bit offset for the I/O Point, and then click Finish to 
conclude. 
 
A quick way to change the position of an I/O Point is clicking it on the memory map and dragging it 
to the new position. Follow the steps below: 
 

1. On the Memory Map View, click the mapped I/O point to select it. 
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Figure 11.31. Selecting the I/O Point 

 
2. Hold the mouse button down while dragging the I/O Point to the new position, on the 

Memory Map View. 
 

 
Figure 11.32. Moving the I/O Point 

 
3. Release the mouse button. A message box will open to confirm the alteration for the 

selected I/O point. 
 

 
Figure 11.33. Confirming the Operation 

 
4. Click Ok to confirm and change the position of the I/O point. Or click Cancel to discard the 

alteration. 
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Figure 11.34. New I/O Point Offset 

 
If the mapping color turns red while moving the I/O point, it means the I/O point cannot be moved to 
that offset, because the position is not available. When you release the mouse button in a position 
that is not available, the I/O point returns to its original offset. 
 

ATTENTION 

Analog I/O Points from the Modbus protocol must have at least two bytes; therefore these I/O 
points can only be mapped in offsets that are a multiple of the type word. Mapping Tool will fill 
the I/O point with other byte if the size of an I/O point has only one byte. 

 
 
Swapping I/O Points 
 
After mapping I/O points from an I/O connection, you can change the position between two I/O 
points, only if these I/O points were not automatically mapped by Mapping Tool. 
 
To swap two I/O points, right-click one of the I/O points icon and click the option Change Position. 
See the example below, where the selected analog I/O point is displayed in dark blue on the 
Memory Map View: 
 

 
Figure 11.35. Selecting the I/O Point 

 
The Change Position dialog box will open. Mark the option Swap I/O Point and select the desired 
I/O point from the list of available I/O points. See the example below: 
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Figure 11.36. Selecting Another I/O Point 

 
Click Finish to conclude. The select I/O Points will be displayed on their new positions, on the 
Memory Map View, as indicated below: 
 

 
Figure 11.37. New I/O Points Offsets 

 
A quick way to swap the position of two I/O points is clicking it on the memory map and dragging 
one of the I/O points over the position of the other I/O point. Follow the steps below: 
 

1. On the Memory Map View, click the mapped I/O point to select it. 
 

 
Figure 11.38. Selecting the I/O Point 

 



SYSCON 6.5 - User’s Manual 
 

11.22 

2. Hold the mouse button down while dragging the I/O point over the position of the other I/O 
point, on the Memory Map View. Note that the mapping color change to green, indicating 
that the I/O point can be swapped in that position. 

 

 
Figure 11.39. Moving the I/O Point 

 
3. Release the mouse button. A message box will open to confirm the alteration. 

 

 
Figure 11.40. Confirming the Operation 

 
4. Click Ok to confirm and swap the positions of the I/O points. Or click Cancel to discard the 

alteration. 
 

 
Figure 11.41. New I/O Point Offset 

 
If the mapping color turns red while moving the I/O point, it means the I/O point cannot be moved to 
that position, because the position is not available. When you release the mouse button in a position 
that is not available, the I/O point returns to its original offset. 
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Using Device Templates 
 
 
From Syscon Version 6.5 on, Mapping Tool allows you to create templates from the devices in the 
network topology. You can then use these templates and copy mapped I/O points from the I/O 
connections to other devices. 
 

ATTENTION 

Mapping Tool cannot create a template file from devices with no mapped I/O points, nor from 
devices with I/O points that were automatically mapped. 

 
 
Creating a Device Template 
 
To create a device template, right-click the device icon and click the option Create Template. 
 

 
Figure 11.42. Selecting the Device 

 
The Create Template dialog box will open. Type the description for the template and click Next. 
 

 
Figure 11.43. Template Description 

 

Click the button  to open the dialog box and locate the folder where the template file will be 
saved. Type the name for the file and click Save to return to the Create Template dialog box. The 
full path to the template file will be indicated. Click Finish to conclude. 
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Figure 11.44. Template File 

 
A message box will open indicating the template file was saved with success. Click Ok to close the 
message box and return to Mapping Tool. 
 
 
Applying a Device Template 
 
To apply a device template created by the user to another device, right-click the device icon and 
click the option Apply Template. 
 

 
Figure 11.45. Applying a Template 

 
ATTENTION 

You can only apply templates to devices with the same model, and devices that are compatible 
in relation to the mapping memory available. 

 

The Apply Template dialog box will open. Click the button  to open the dialog box and select 
the template file. Locate the folder where the template file was saved and click the file icon to select 
it. Click Open to return to the Apply Template dialog box. The full path to the template file will be 
indicated: 
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Figure 11.46. Selecting the Template 

 
Click Next to proceed. Type the description for the device template and click Finish to conclude. 
 

 
Figure 11.47. Template Description 

 
A message box will open indicating the template file was applied successfully. Click Ok to close the 
message box and return to Mapping Tool. 
 
The I/O points from the device template will be applied to the selected device. See the example 
below: 
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Figure 11.48. Example of Device Template 
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